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Thru-Put Synchronization 
Thru-Put Synchronization engine is the core of the Thru-Put suite. Most of what a plant needs is generated during a 

scheduling session in Thru-Put: 

• Increase throughput 

• Reduce WIP 

• Reduce operating expense 

 

Before you start Planning with Thru-Put, we need to set up working calendars for the workcenters so that their 

capacity and working start and end times are correctly interpreted and their schedules are valid in the shop floor. 

 

Calendars in Sync Engine 

Thru-Put Sync Engine supports 2 different kind of Calendars: 

• Regular Calendar 

• Shift Calendar 

Regular Calendars have single shift working on a day starting from 00:00 hours; while Shift Calendars can have one 

or more shift (max 3 shifts supported) working on a day where user can specify exact shift start time for each of the 

shift. Regular Shift information is stored in CALPOLY and CAL tables; and Shift information is stored in 

CALPOLY_SHIFTS and CAL_SHIFTS tables. 

Please note, user can have both information populated for both Regular Calendars as well as Shift Calendars in the 

back-end tables. Application will make use of Regular Calendars for planning if USE_SHIFT_CAL=0 in RESPARA 

table; else will make use of Shift Calendars. User can always switch between Regular and Shift Calendar from UI; but 

they need to reload the project after switching calendars to ensure schedule accuracy and validity. 
 

Regular Calendar 

When you select DB Maint -> Calendar, the following dialog box appears: 

 

Note: If Calendar Maintenance Button is disabled we need to go to DbMaint->Calendar->Using Calendar->Regular 

option. 
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In Calendar dialog we can create new calendars and define working hours for specific days using below options. 

Default Working Hours per Day: Here we can define working hours let’s assume we gave 17 Hrs. 

Start Of Week: we can define the starting day for every week in Calendar. 

Working days In Week: Define no of days in a week. 
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Now we will create a calendar KAC by giving Start Date-03/03/2021, End Date-07/03/2021. In below screen we have 

created Calendar that is having 17 Working Hrs and it works only on Monday. This information is Stored in 

CALPOLY, CAL_SHIFTS table. 

 

 

User can change Working Hrs from Default Working Hours Menu by clicking on Default followed by Save button will 

save information to all defined dates till Calendar End Date. 

Note: User can change working Hrs on selected Dates as well by using Edit button. 

New Calendar: User can create new calendar. 

Duplicate Calendar: We can create a duplicate calendar for existing Calendar. 

Associate: We can associate workcenter with Calendar. 
 

Shift Calendar 

Shift Calendar is mainly intended to give facility to track the employees working hours on shift basis. (EX: Shift1: 7AM 

– 3PM, Shift2: 3PM – 11 PM and Shift3: 11PM – 7AM). 
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Using shift calendar it is easier to specify the shift duration and the number of units working on each shift in a weekly 

policy basis 

To use shift calendar User has to select Calendar first to enable Shift Calendar Maintenance Button/Menu. 

 

 
User can find the button or menu as given in below figure. Menu is located under DBMaint. And button is located 

near to Calendar Maint button. 
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On choosing Shift calendar from DB Maint->Calendar->Using Calendar(Shift) menu, User will get message if Shift 

Information does not Exist. 
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Clicking on yes will ask the user to set a default calendar for following locations as shown in figure. 

Note: If Shift Calendar menu/Button is enabled, click on Shift calendar button to create shift. 

 

 
Click on Yes. If customer already has Regular Calendars created but now want to switch to Shift Calendars; then 

application will display below dialog where it will ask user if they want to automatically create Shift Calendars using 

Regular Calendar data which exists 

 

 

• On clicking “Yes” in above dialog, application will automatically create seperate Shift calendar corresponding to 

each Regular Calendar and will display below screen where they can see the Shift Calendar created. 
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• On clicking “No”, application will pop-up "Create New Dialog" should pop up to define the start date and end 

date. 

 

 

Once user has entered dates and press “OK” the “Shift Calendar Dialog” should pop up with saved information from 

above mentioned dialog like Calendar ID and Location ID and Associated Work Centers as shown in below fig 
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User has the flexibility to choose either of any view and can store information for particular view as shown below. 

 

 

Regular Shift View 

This view is used to store the normal shift working hours of employee for entire week. On double clicking on any 

particular cell the of this view user will be prompt with “Add Regular Shift” dialog with default shift timings as shown 

below, 

Note: For very first time when user has configured the shift calendar the default calendar needs to be saved by 

adding regular shift on double clicking on any of the row or exception shift by double clicking on any particular cell. 

This has notified to user by a given status bar as shown in the above figure with red line marked. 



THRU-PUT Advanced Planning and Scheduling User Guide  

  
Infor Confidential- Please do not distribute Page 13 

Add Regular Shift 

 

 
 

Here Shift1 and Shift2 information will be available by default with Shift3 as an optional for user. Default shift timings 

are: 

• Shift1: 07:00 AM – 03:00 PM 

• Shift2: 03:00 PM – 11:00 PM 

• Shift3: 11:00 PM – 07:00 AM 

User can change the timings by clicking on Monday start at and length timing and the changed timing can be 

reflected for entire week once user has selected the “Copy from Monday” check box. 

On clicking “OK” the entire shifts information will be reflected and “Save” button will be enable in the regular shift view 

window as shown below. 
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On clicking save the entire shifts information will be stored into database. 

Edit Regular Shift 

 

If user wants to change the already saved regular shift information, he/she has to double click exactly on the saved 

shift row of either shift 1 or shift2 of any cell. Once edit regular shift dialog will pop up with saved information user can 

edit the values and saved back to database again with pressing OK button followed by Save button. 
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Validation for Regular Shift Timing: 

 

The Shift2 start time should be greater than or equal to Shift1 end time. Likewise the Shift3 start time should be 

greater than Shift2 end time and Shift1 end time(if Shift2 time is blank). If user has selected some wrong timing then it 

should prompt user about the invalid shift timing as shown in below message. 
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Timings will be added to the view but unless it is rectified the save button will be disable which will prevent the user to 

save the wrong shift information’s to the database. Once user has rectify the shift information’s then only Save button 

will be enable and will be able to save the information’s back to DB. 

 

 
 

The regular shift records are stored into the CALPOLY_SHIFTS table of thru-put database. 

Exception View 
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This is used to track the exception working hours for any particular dates of the month, Such as employee has 

worked only 3-4 hours from 11th November to 12th November of that particular month. 

User has to select the Exception view as show in below: 

 

 
 

ADD SHIFT CALENDAR EXCEPTION 

 

On double clicking on any particular cell user will be prompted with Add Shift Calendar Exception dialog as shown 

below. The default exception shift information’s should be derived from working periods of Regular shift like (7:00 AM 

to 3:00 PM etc) 

 

If user has press OK without changing the exception shift time then nothing should be saved to the DB, hence no 

exception information should be added to view as well. But once user has modified the exception shift timing the 

timing should be added to DB as well as to the view of calendar on pressing OK button. 
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User can select start date and end date with shift information from the dialog and on pressing “OK” the exception will 

be saved to view for selected date. In below screen we have given exception in 3 shifts, in each shift we have 

specified 1 hour as shown below. 
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EDIT SHIFT CALENDAR EXCEPTION 

 

If user wants to change the already saved Exception shift information, he/she has to double click exactly on the saved 

Exception shift row (marked in yellow color) of shift 1, shift2 or shift3 of any cell. Once edit Shift Calendar Exception 

dialog will pop up with saved information user can edit the values and saved back to database again by 

pressing OK button. 

 

 
 

You can create a new shift calendar or duplicate a new one using existing one. You can also associate work centers 

with this calendar using the menu shown below. 

 

 
 

Next month and previous month Exception 

 

User can move to next month as well as previous month in order to track the exception records as shown in below 

figure. 
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The exception shift records are stored into the CAL_SHIFTS table of thru-put database. 

Add Exception Rules 

Add Holiday exception will help the users to add holidays and exception to shift calendars for single/multiple years 

(up to CAL_END). CAL_END date will be picked from RESPARA table’s CAL_END_DATE parameter. If this 

parameter is not defined in RESPARA table then CAL_END date will be set as for next 5 years from Horizon start 

date. 

 

If Plant is having multiple locations then we can’t apply Holiday/Exception in a single go for all locations. User has to 

select one location at a time and repeat the same for all locations. 

 

Users can easily define day off/Half day according to their plan.For example 1st Jan New Year’s Day, Last Monday of 

May Memorial Day, 4th July Independence Day, 25th Dec, Last Saturday of the month etc… 

Requirements: 

• To define holiday by dates like January 1st, July 4th, December 25th. 

• To define holiday like last Saturday of the month. 

• To define Last or first or 1st/2nd/3rd/4th of May month. 

• To define Last or first or 1st/2nd/3rd/4th of and extend to the earlier week end in case of Tuesday or later week 

end in case of Thursday. 
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When user clicks on any cell from exception view then Add/Edit Shift calendar exception dialog will popup: 

 

 
 

From the above dialog user can define shift calendar exception not holiday for single calendar only at a time. Now the 

menu option “Add Exception Rules” has been implemented to define holiday/Exception both either single calendar or 

multiple calendars in a single location at a time. 
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When user clicks on “Add Exception Rules” menu option add Holiday/Exception dialog will display as shown below: 

 

 
 

If user has not selected any cell from exception view then Start date and End date will be set to current date (today’s 

date) and shift information will be displayed in the dialog for this populated start date. Already if any exception has 

been defined for this start date then exception information will be displayed in shift fields otherwise regular shift 

information will be displayed (as defined for the week days in calendar). 

 

Note: Please note if applied Holiday/Exception is not displaying in exception view on the selected date then 

open Import.log file and view the error message. If any error has occurred while applying Holiday/Exception. 

The popup message will not be displayed. The error message will be written in Import.log file (Error message 

like shift overlapping error, shift is not valid or shift is not created for the calendar). 

Plan Holiday/Work off/Half day functionality is defined below: 

 

Holiday Check box will tell the added exception is a holiday. If it is checked, then all shift information will be set to 0 

and shift controls will be grayed out (User can’t change shift). Apply to all calendars checkbox will also be 

automatically checked and grayed out. User don’t have the option to uncheck it with Holiday checkbox checked. The 

provided information will be written in both HOLIDAYS and CAL_SHIFTS tables. Else will be considered as normal 

exception and user provided information will be written to CAL_SHIFTS table. 
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Holiday Feature 

 

Holiday defines day off. If it is checked then Shift controls and Apply to all calendars checkbox will be grayed out i.e. 

there will be no working hours for the date. 

 

This will help the user to define the fixed holidays like 1st January, 25th December etc… . These dates will never 

change year to year, so user has flexibility to define holidays over multiple years (up to CAL_END date) by selecting 

apply date to all years rule. 

 

Please refer to below screen to define 1st January (New Year’s Day) as Holiday for current year. 

 

 
 

The Holiday information will be written to both tables HOLIDAYS and CAL_SHIFTS as given below: 

 

Table HOLIDAYS: 
LOCATION_ID HOLIDAY 

Chine 2021-01-01 

 
 
Table CAL_SHIFTS: 
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LOCATI
ON_ID 

CALEND
AR_ID 

START
_DATE 

END_
DATE 

SHIFT1_
START 

SHIFT1_L
ENGTH 

SHIFT1_
UNITS 

SHIFT2_
START 

SHIFT2_L
ENGTH 

SHIFT2_
UNITS 

SHIFT3_
START 

SHIFT3_L
ENGTH 

SHIFT3_
UNITS 

China Default 2021-
01-01 

2021-
01-01 

0 0 0 0 0 0 0 0 0 

Note: Apply to all years rule will be used to define holidays for all years (up to Calendar End date). The Holiday 

information will be written to both tables HOLIDAYS and CAL_SHIFTS. 

 

Apply to all calendars 

 

Apply to all calendars option will be used to write shift information for all calendars in the specified location. If it is 

unchecked, then shift information will be written for selected calendar in the specified location. 

 

If Holiday checkbox is checked with Apply to all Calendars checkbox, then Shift information will be written in both 

tables HOLIDAYS as well as CAL_SHIFTS. If it is unchecked then shift information will be written to CAL_SHIFTS 

table. 

 

Please refer the below screen to define common shift for all the calendars in the specified location by using Apply to 

all calendars option. 
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In the above screen shot user has selected start date as March 17, 2021 and End date as March 17, 2021 and 

provided the exception shift information. By this option user has applied exception for these selected date in one go 

for all the calendars in the specified location. 

 

Note: 

• Please note if user has not selected any option, only shift information has been provided then same 

information will be written in CAL_SHIFTS table. 

• Please note if user has neither selected holiday checkbox nor changed displayed shift information, then 

software will pop up a display message and ask the user to save the default shift information “No Shift 

Exception Information has been provided. Do you want to save the default values displayed here as 

exception?” If user clicked “Yes” then shift information will be written in CAL_SHIFTS table for the 

selected date, calendar in the specified location. 
 
 

ADD RULES 

 

Apply date to all years (Rule 1): 

 

If Apply Date to all Years is selected, then Dates Entered in Start Date and End date (Date Month), Date will be 

applied from Horizon Start to Calendar Date end (CAL_END defined in RESPARA table). For Example, if December 

25th is selected, then starting 2021 thru Calendar End (assume 2023), 12/25/2021, 12/25/2022, 12/25/2023 will have 

the rule applied. This is useful for defining Christmas day, Independence Day etc… where dates don’t change from 

year to year 

 

Please refer the below screen to define 15th August Independence Day as Holiday: 
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The Holiday information will be written to both tables HOLIDAYS and CAL_SHIFTS as given below: 

 

Table HOLIDAYS: 
LOCATION_ID HOLIDAY 

China 2021-08-15 

China 2022-08-15 

China 2023-08-15 

 
 
Table CAL_SHIFTS: 

LOCATI
ON_ID 

CALEND
AR_ID 

START
_DATE 

END_
DATE 

SHIFT1_
START 

SHIFT1_L
ENGTH 

SHIFT1_
UNITS 

SHIFT2_
START 

SHIFT2_L
ENGTH 

SHIFT2_
UNITS 

SHIFT3_
START 

SHIFT3_L
ENGTH 

SHIFT3_
UNITS 

China Default 2021-
08-15 

2021-
08-15 

0 0 0 0 0 0 0 0 0 

China Default 2022-
08-15 

2022-
08-15 

0 0 0 0 0 0 0 0 0 

China Default 2023-
08-15 

2023-
08-15 

0 0 0 0 0 0 0 0 0 

 
 
Note: 
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• If Holiday, Apply to all calendars checkbox is unchecked then provided shift information will be written to 

CAL_SHIFTS table for selected calendar in specified location. 

• If Holiday checkbox is unchecked and Apply to all calendars is checked then provided shift information will be 

written to CAL_SHIFTS table for all calendars in the specified location. 

Apply week day of month to all months (Rule 2): 

 

If Apply Week Day of Month to all Months is selected, this means Thru-Put looks at the week day of the month like 

2nd Saturday of the month or 3th Saturday of the month etc… and then apply the same data to all months, January, 

February thru December. Exact date may vary from month to month. It repeats the same rule also for all the years 

(up to CAL_END) if all year’s checkbox is checked. This will help the user to defining monthly work off/half day such 

as Inventory Cycle Count Day. 

 

Please refer the below screen to define 2nd Saturday of month as Half day. If Apply to all calendars is checked then 

provided information will be written for all calendars Else for the selected calendar in the specified location. 

 

If all year’s checkbox is checked then information will be written up to Calendar End date Else for current year. 
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Apply week day of month to all years (Rule 3): 

 

If Apply Week Day of Month to all Years is selected, this means Thru-Put looks at the week day of the month say Last 

Thursday of the month, and then apply the same data to all years up to CAL_END (CAL_END is defined in 

RESPARA table). Exact date may differ from year to year. This will help the user to define holidays such as Memorial 

Day, Thanks Giving etc. 

 

Rule 3 differs from rule 2 because of by using rule 2 option we can define day off/half day for every month in the year. 

But by using rule 3 option we can define day off/half day for a particular month in the year. 

 

Please refer the below screen shot to define Last Thursday of November month as Thanksgiving Day. 

 

 
 

The Holiday information will be written in both tables HOLIDAYS and CAL_SHIFTS as shown below: 

 

Table HOLIDAYS: 
LOCATION_ID HOLIDAY 

China 2021-11-25 

China 2022-11-24 
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China 2023-11-30 

 
 
Table CAL_SHIFTS: 

LOCATI
ON_ID 

CALEND
AR_ID 

START
_DATE 

END_
DATE 

SHIFT1_
START 

SHIFT1_L
ENGTH 

SHIFT1_
UNITS 

SHIFT2_
START 

SHIFT2_L
ENGTH 

SHIFT2_
UNITS 

SHIFT3_
START 

SHIFT3_L
ENGTH 

SHIFT3_
UNITS 

China Default 2021-
11-25 

2021-
11-25 

0 0 0 0 0 0 0 0 0 

China Default 2022-
11-24 

2022-
11-24 

0 0 0 0 0 0 0 0 0 

China Default 2023-
11-30 

2023-
11-30 

0 0 0 0 0 0 0 0 0 

 
 
 

Exceptional Behavior 

Let’s understand few things that we can keep in mind while adding Holiday/Exception: 

• If User has not applied Holiday for the selected date then provided shift should not overlap previous day and 

Next day shift. If provided shift for the selected date is overlapping then Software will not popup an error 

message. It will log an error message in Import.log file. 

• If Start and End date are not same and having one or more day’s difference and user has selected either Rule2 

or rule3. While user clicking OK button to apply Holiday/Exception then software will pop up an error message : 

"Selected Rule can't be applied for given Start and End date." 

• Suppose user has marked a holiday/Exception in leap year (say February 29 2020) for all the years (up to 

CAL_END). Please refer the below screen: 
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Software will look for the leap year to mark holiday if it exists, otherwise it will round down the date to one day then it 

will mark as holiday. Please refer the output of HOLIDAYS table: 

 

Table HOLIDAYS: 
LOCATION_ID HOLIDAY 

China 2020-02-29 

China 2021-02-28 

China 2022-02-28 

China 2023-02-28 

China 2024-02-29 

China 2025-02-28 

China 2026-02-28 

China 2026-02-28 

China 2028-02-29 

Note: If user’s selected day falls in Last week of the month and rule is selected for all the years then software will find 

the same day in last week of month for the coming years and will mark it as Holiday. For example: 
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Last Friday, November All Years 

 

 
 
The output will be as shown below: 
 

LOCATI
ON_ID 

CALEND
AR_ID 

START
_DATE 

END_
DATE 

SHIFT1_
START 

SHIFT1_L
ENGTH 

SHIFT1_
UNITS 

SHIFT2_
START 

SHIFT2_L
ENGTH 

SHIFT2_
UNITS 

SHIFT3_
START 

SHIFT3_L
ENGTH 

SHIFT3_
UNITS 

China Default 2019-
11-29 

2019-
11-29 

0 0 0 0 0 0 0 0 0 

China Default 2020-
11-27 

2020-
11-27 

0 0 0 0 0 0 0 0 0 

China Default 2021-
11-26 

2021-
11-26 

0 0 0 0 0 0 0 0 0 
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Troubleshooting Errors while creating Shift Calendar 

ERROR 1: After creation of shift calendar when user loads the project and gets below kind of error message: 

 
 

This error indicates you have created shifts but for those shifts some or none of the workcenters have no units for 

working in any of these shifts which you have defined in Shift Calendar dialog. 

 

Now we can check these units in WKCTR table, how many units of each workcenter is working in which shift. In 

WKCTR table, you get 4 columns listed below: 

 

UNITS => This indicates total number of units for a workcenter. This is used by regular calendars. 

UNITS1 => This indicates units working in first shift i.e. in Shift1. Here UNITS1 <= UNITS. This is used by shift 

calendars. 

UNITS2 => This indicates units working in second shift i.e. in Shift2. Here UNITS2 <= UNITS. This is used by shift 

calendars. 

UNITS3 => This indicates units working in third shift i.e. in Shift3. Here UNITS3 <= UNITS. This is used by shift 

calendars. 

 

If there is no record for those fields in WKCTR table then we need to follow this step: 

 

User can populate values for these fields UNITS1, UNITS2 and UNITS3 in WKCTR table either by downloading data 

in WKCTR.dat file and mapping the same using fmt file or user can manually update each workcenter record for 

these columns from Workcenter sub-menu under DbMaint main Menu. 

ERROR 2: If a user has marked a date as holiday in Normal Calendars and do not getting correct load/Capacity 

information on Timephased Load Profile window (Even he/she still displaying positive load and capacity for this 

Holiday date). 

 

Suppose a user has created Normal Calendar ‘MLG1’ from Start Date ‘01/01/2018’ and End Date ‘12/31/2020’, 

having capacity of 8 hours/day. This calendar is associated with a workcenter ‘MLG11X’. 
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Now the user has marked Holidays on the Dates ‘08/05/2021’ and ‘08/12/2021’ in holiday table. This issue is arisen 

due to data error because Calendar “MLG1” is having End Date as ‘12/31/2020’ in CALPOLY table and there was no 

data for the year ‘2021’ in CAL table for this calendar ‘MLG1’. The application will not behave correctly, so either the 

user may get incorrect information on the time phased load profile window as shown in the below screen. 

 
 

To resolve this issue to get correct information please extend the Calendar End Date to ‘12/31/2021’ from Calendar 

maintenance Dialog for the calendar ‘MLG1’. After extending the End Date of the calendar, TimePhased Load Profile 

window will display load and capacity as 0 correctly for the Dates 08/05/2021 and 08/12/2021 as shown in the below 
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screen. 
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Loading the Plant Data in memory for Planning  

Thru-Put does in memory calculation that helps to do planning blazing fast and flexible. First step in planning is to 

Load the plant data from database to memory.  Go to main Synchronization menu and  click  on File -> Load Project.  

You will see data getting read from each input table and loaded into memory. Once the project is loaded hit on ok 

button in the dialog. Once project is loaded in memory, you will see 2 buttons (as displayed below) on the left side of 

a Thru-Put menu bar which represent the Synchronization and Resynchronization processes: 

 

 
 

Synchronization lets you create a weekly schedule, and 

Resynchronization lets you perform daily updates and account for new orders with a minimum impact on the shop 

floor. 

To use Thru-Put scheduling, first identify the constraints in the plant. The most constrained resource in the plant is 

the drum, because it determines the pace of the entire plant. Once you have identified the drum, Thru-Put assists in 

planning a schedule for the drum that makes the most of its potential capacity. After you schedule the drum, Thru-Put 

schedules the rest of the plant so the plant keeps pace with the schedule of the drum. 

This chapter discusses Synchronization in sections that echo the focusing steps of the theory of constraints (TOC). 

• Identifying constraints 

• Seeing past-due orders: Cacophony 

• Exploiting the constraint: Harmony 

• Sub-Ordinating non-constraints - Subordination 

• Understanding flexible buffers 
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Identifying constraints 

You can identify the following when you use the Thru-Put Synchronization engine: 

• Machine constraints 

• Minimum lead times 

• Labor 

Thru-Put accounts for machine constraints using the Workcenter Load Profile to show you workcenters so you can 

determine the most constrained resource. The Material Planning display performs a similar task for identification of 

material constraints 

 

Machine Constraints 

The most constrained resource in a plant determines the throughput of the plant. Certain information is critical to 

determining the most constrained resource. Before you identify a machine constraint, you must know how much work 

the machine has to process (the load), as well as the amount of work the machine is realistically able to process (the 

capacity). 

Thru-Put determines machine capacity based on the number of working hours in the calendar and the number of 

units in the workcenter. WIP and inventory in the system are allocated to earlier orders whether or not the order is a 

customer or forecasted order. Thru-Put prioritizes orders that appear on the same day in the order in which you 

download them from the host and by the completion date in system memory. 

Thru-Put calculates one customer or forecast order at a time. In contrast, MRP calculates a requirement’s final 

assembly across all customer orders, then calculates the next level down, and so forth. 
 

Workcenter Load Profile / L:C Chart 

The Workcenter Load Profile lets you identify drums quickly and easily, as a drum is more than likely to be the 

workcenters nearest the top of the list. It is a bar chart that shows the ratio of workcenter load to total capacity. The 

load is adjusted by a percentage of the setup time. Each runtime is multiplied by the percentage of the setup time in 

order to determine the load. For example, if the runtime for a workcenter is 10 minutes and the setup percentage is 

30 percent, 13 minutes of load is placed on this workcenter. 

Workcenters appear in descending order by percentage so you can identify the ones with the highest loads relative to 

their capacity. 

http://localhost/tphelp/Modules/SyncEngine/index.html
http://localhost/tphelp/Modules/SyncEngine/index.html
http://localhost/tphelp/Modules/SyncEngine/index.html
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To see the load-to-capacity chart (L:C), click on the horizontal bar graph icon on the tool bar or select Steps > 

Identify > Machine Constraints. The chart presents load-to-Capacity ratios for the scheduling horizon you 

established when you started Thru-Put. The top portion of the chart provides details about the workcenter (for 

example, the number of units, the ID of the calendar associated with the workcenter, and the workcenter family). A 

typical L:C Chart looks like below: 

 

 

This Load versus Capacity Chart (also referred to as L:C Chart) is a useful tool to get a quick summary of overall load 

on each workcenter facilities; all the job requirements coming from your customer sales orders, forecasts, safety 

stocks and master plan of assemblies for the planning horizon (shown in the application toolbar on the top) on each 

work centers facilities determine the total load. This load when compared with the available capacity of each work 

center facilities (working hours of the facilities and the number of machines available) help you determine the 

overloaded and underloaded workcenter facilities. This ratio is expressed in percentile bar graph for benchmark 

comparison. Any workcenter that exceeds threshold 100% value (as shown with a thick red line running from top to 

bottom in the chart below) is overloaded. Total load i.e. Processing Time and setup time and capacity for the planning 

horizon is listed in the table on the right. 

This chart displays stacked bar-chart view for percentage of load caused by Released work Orders, from Firm 

Planned Orders and from Planned work orders. Lighter shade coloring in the same bar is used to show the load from 

each type work orders shown below. This information will also get highlighted when user hovers the mouse over any 

workcenter as you can see from above screenshot which shows Mfg Load, Firm Load and Pln Load. 

To search for a particular workcenter: 
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1. Click on the magnifying glass icon from the tool bar. The Select Workcenter dialog box appears. 

2. Select the workcenter. You can click on the workcenter or type in the name of the workcenter. 

By default, the Ignore Case box is checked. You can type in upper- and lowercase characters. If the Ignore 

Case box is not checked, Thru-Put matches the exact case you type in. 

Loads and capacities for workcenters with specified families are aggregated and appear by family using this selection 

under the Analysis menu. 

You can arrange how the chart appears by selecting one of these options: 

Sort by Load. By default, the chart is sorted by family load. 

Sort by WC Family. The chart is sorted in alphabetical order. 

To sort the workcenters: 

 

1. Press the Shift key and the right mouse button at the same time to see the menu. 

2. Select the sort order you want by clicking on it. 

You can click on any bar and then double click on a bar to do the drill downs. In the drill down window also, you will 

see the load components for each type of work orders. 

Bucketized load 

To see the time-phased distribution of load-to-capacity on any workcenter, do one of the following: 

• Highlight the corresponding horizontal bar in the L:C chart and click on the vertical bar icon 

• Highlight the corresponding horizontal bar in the L:C chart, right-click and select Timephased Load Profile 

The L:C for various time buckets for the selected workcenter appears as shown below. Again, a percentage of the 

setup time is used to adjust the load. You can see the number of hours of overload or excess capacity in each bucket 

to help you understand where the over- and underloads are. You can adjust the size of the buckets to daily, weekly, 

or monthly by selecting Display > Bucket Size. When you close the Time-Phased Load Profile window, the bucket-

size changes take effect. 
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In this chart too, you can see how much load in each bucket is coming from Manufacturing Orders, Planned Orders 

and Firm Planned Orders depicted by color coding used. 

Drums 

If your routing information is inaccurate or incomplete, you cannot rely on the Workcenter Load Profile information to 

identify drums. You can use one or more of the following techniques to identify potential drums: 

• Workcenter queues 

• Part shortages 

• Overtime 

• Expediter intuition 

Thru-Put shows you two windows: the Workcenter Load Profile window i.e. L:C Chart window and another window to 

the right that shows the list of selected drums. To select a drum, highlight the horizontal bar for the corresponding 

workcenter, right-click on it which will display popup menu. From there, select Add to Drum List menu option in the 

Workcenter Load Profile Chart. The workcenter ID appears in the Selected W/Cs window. Please note, you can 

make updations to drum list only in Synchronization module. In ReSync, you cannot make changes to existing drum 

list. 
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You can edit the selected drums list once you have identified them. Use the Delete, Shift Up, and Shift Down keys. 

The sequence of drum identification is significant. If you identify drum A followed by drum B, the schedule of drum B 

is subordinated to the schedule of drum A. 

See the Concepts Guide for more information. 

Scheduling drums 

Identifying the drums is one of the most critical decisions you make when you implement Thru-Put. Once you have 

identified the drums, you must properly exploit them. 

This is done by clicking Harmony button from the top menu-bar in Thru-Put screen. 

 

 

Harmony is used for scheduling a drum that allows for many decision-making capabilities in order to exploit the 

drum's capacity and maximize its throughput. 
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Please refer to Exploiting the Constraint section for more information. 

Simultaneous versus sequential identification 

TPM lets you identify drums sequentially or simultaneously, or a combination of both. 

Simultaneous Declare all drums and then perform Synchronization on each individual drum 

Sequential   Declare each drum and individually perform Synchronization on them 

Combination Declare a drum and perform Synchronization on it, then declare a set of drums and perform 

Synchronization on them; then go back and identify more drums if needed. 

For example, you want to declare four drums, A, B, C, and D. 

• To declare the drums simultaneously, declare A, B, C, and D as drums. Perform Synchronization on A, then on 

B, then on C, and finally, on D. 

• To declare the drums sequentially, declare A as a drum, then perform Synchronization on A. Then declare B as a 

drum, and then perform Synchronization on it, and so forth. 

• To combine the identification, declare A as a drum and perform Synchronization on it. Then declare B and C as 

drums simultaneously, then perform Synchronization on B followed by Synchronization on C. Finally, declare D 

as a drum and perform Synchronization on it. 

Simultaneous identification. Simultaneous identification of drums is useful when: 

• Drums interact or conflict with each other. When a lower priority drum feeds a higher priority drum, the two drums 

are said to interact. If a higher priority drum feeds a lower priority drum, TPM declares that the two drums do not 

interact. 

 

For example, if you identify drums sequentially, you first identify and schedule drum A. TPM does not know the 

existence of drum B and so it schedules drum A assuming there is no drum feeding it. When you declare B next, 

B has capacity constraint and cannot be scheduled to meet the constraint of drum A. Drum B conflicts with drum 

A. 

 

• You know the sequence of the drums. TPM numbers the drums in the order in which you declared them in the 

Selected Drum list. The order in which you select drums is significant. The first drum on the Selected Drum list 

has a higher priority. TPM subordinates the schedules of all lower number drums to the schedules of a higher 

number drum. 

 

For example, you declare your drums in the sequence A, B, and C. TPM numbers them 1, 2, and 3. Drum A has 

priority over drums B and C. Drum B has priority over drum C. TPM schedules drum A first. It subordinates the 

schedules of drums B and C to the schedule of drum A. If drums B and C feed drum A, TPM schedules drum A 
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first and schedules tasks on drums B and C based on the schedule of drum A. Similarly, TPM subordinates the 

schedule of drum C to the schedule of drum B, as well as subordinating the schedule of drum C to the schedule 

of drum A. 

Sequential identification. Use sequential identification of drums when you are not sure which drums exist in your 

plant or if you are not sure about the relative priority of each drum. Sequential identification gives you a clearer 

picture of the workload of the machine. 

For example, workcenter B feeds workcenter A and is loaded to 120 percent of its capacity. Workcenter A is loaded 

to 140 percent of its capacity. If you schedule workcenter A as a drum, the load on workcenter B automatically drops 

below 100 percent. This helps you understand that workcenter B is not a drum. The same logic applies when 

workcenters A and B feed a common assembly. As soon as you schedule workcenter A, the load on B drops. 

Scheduling one drum at a time also makes the relative priority of drums more clear. You start with the most loaded 

workcenter and work your way down. The disadvantage of sequential identification is when drums interact. See See 

“Interacting drums” for more information. for more information. 

Interacting drums. When drum B feeds drum A, and drum A is higher priority than drum B, the two drums are said to 

interact. If a lower priority drum feeds a higher priority drum, the two drums interact. If a higher priority drum feeds a 

lower priority drum, the two drums do not interact. This interaction should be minimal. If 50 percent of the tasks from 

drum B feed drum A, only drum A is a drum. 

If you identify drums sequentially, identify and schedule drum A first. TPM does not know that drum B exists yet and 

so schedules drum A assuming there is no drum feeding it. When you declare B next, it may have capacity constraint 

and may not be scheduled to meet the constraint of drum A. Drum B conflicts with drum A. 
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Waiting Load Inventory in Sync Engine and TPWeb 

This consolidated report of Thru-put which will help shop floor managers and supervisors who are interested in 

knowing the waiting work status on the shop floor and accordingly manage the inventory. For each work center, the 

waiting inventory load is calculated from the released assembly work orders to be processed. For waiting load 

calculation, qty will be considered from open job step which can be released. 

This report will help the users to analyze which customer orders will be impacted by this waiting inventory. To open 

the waiting inventory window, click on the toolbar button as highlighted in below screen 
 

 

 

Below screen will be displayed where green color indicates waiting inventory load and gray color indicates daily 

capacity. A drilldown feature is also available for each workcenter in the graph below. 
 

 

 

Please note, only those released work orders will produce load on work centers which satisfy below conditions: 
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1. A released work order which does not require any component on open job step and ready for processing through 

assigned work center. 

2. A released work order which requires components on open job step and all requirements are satisfied from OnHand 

and ready for processing through assigned work center. 

3. A released work order which requires components on open job step and all required components are already issued. 

This report is also available in TPWeb under custom reports tab as shown in below screen: 
 

 

In TPWeb, it will display load from those released workorders which require components on open job step and all 

requirements are satisfied from OnHand or they are released from stock as shown below: 
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Labor Constraints 

Thru-Put lets you see labor overloads at all workcenters and skilled labor sets. You can move work to another 

workcenter if required. The information is a snapshot for the horizon you select. 

You can input labor information via the Labor table using DBMaint or during download. This function lets you identify 

the skilled labor sets that need to be modeled. Set the labor capacity by changing the length of the workday or 

workweek in the calendar and by changing the number of people working the particular calendar. You can also map 

labor to the set of workcenters on which the skilled labor set can work. Thru-Put limits the amount of mapping you 

can do in order to avoid non-overlapping subsets. 

If you have an overload at a specific workcenter, double click on the workcenter. Nonconstrained resources have 

protective capacity to allow for Murphy. 
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Material Constraints 

INFOR THRU-PUT helps you detect and handle raw material shortages so that you can produce feasible schedules. 

The big difference between capacity and material constraints is that material availability tends to be more flexible than 

capacity availability. Except for a few materials (called hard material constraints), materials procurement schedules 

can be modified by negotiating with your vendors. 

 

To access this menu, please click on Steps -> Identify -> Material Constraints. 

See the Planning Materials section for more information on Material Constraints Planning. 
 

Planning materials 

Thru-Put’s material handling capabilities include the following: 

• Identify minimum MRP lead time 

• Modify purchase orders 

• Push-out choices 

• Prioritized raw materials by lateness 

Mismatches between supply and demand generate lateness. Supply is determined by the quantity on hand and the 

purchase orders. Demand is determined from sales orders and forecasts. You can use this lateness factor to assist in 

your material planning. Thru-Put divides lateness into three categories with subsequent colors appearing to help you 

comprehend any schedule problems: 
Green Safe 

Yellow Warning 

Red Late 

 

Identifying minimum MRP lead time 

Material lead time consists of three components. 

• Buyer lead time 

• MRP lead time, approximate time frames for given parts: 

o Minimum: The average expedited time in which to buy a part 

o Typical: The average normal time in which to buy a part 
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• Dock to stock time. 

Define different lead times for each primary vendor. In Thru-Put, the MRP lead times can greatly affect new purchase 

orders and can have an indirect affect on firm purchase orders, but will have no impact on quantity on hand. MRP 

lead time is almost exclusively defined by the primary vendor, but you and the vendor can negotiate minimum lead 

times. 

To declare material constraints, do the following: 

• Select Synchronization Engine. 

• Select Steps > Identify > Material Constraints. The Material Planning Configuration dialog box appears. 

 

Filter For Material 

Buyer ID If specified, only a purchased part with a specified buyer ID appears. You can see all buyers or only a 

selected buyer. One of the following: 

 

   1 Raw material 

   3 Consigned part. 
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Priority Material Only If checked, Thru-Put considers only priority materials. If you specified a buyer ID, only priority 

parts from that buyer appear. Priority materials must be buyer parts and have a raw material type of priority. If this 

field is not checked, both priority and normal materials appear. 

Coloring zone You can determine the number of days in the yellow (warning) zone. This lets you ensure that the 

material is on schedule. The lateness value is a negative number because the material is not yet late. The red (late) 

zone is determined as anything greater than zero; consequently, you cannot change the information in this field. 

Display Option Select one of the following to determine how your material penetration ratio appears: 

 
Bar The material penetration ratio appears in bar chart format. The bar chart shows only items in the red zone 

because other zones have no delays. The bar value is negative. Use the bar chart for sales and marketing 
purposes. 
The bar chart is sorted by descending lateness, then by ascending MRP lead time. 
  

Table The material penetration ratio appears in a grid table format. Use the table format for most purposes as it 
contains more fields. 

Part The part ID from the Part table. 

Minimum Lead Time The minimum MRP lead time in working days, derived from the Part table. 

Worst Lateness The items with the worst lateness appear in red; warnings appear in yellow. 
 

Tolerance for 
lateness 

Type in a negative number to see parts in the yellow or green zone. The default is zero, which shows you only 
red zone material. 

Defer Refresh 
Mode 

If checked, you must manually refresh your material plans if you change something. Otherwise, Thru-Put 
automatically refreshes your material plans after each modification. 
To refresh material planning, select Decisions > Refresh Material Planning. All displays are updated to reflect 
your changes 
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Material Constraint Bar Chart View 
You can check out the material constraint in bar chart view as shown below. 

 

Material Constraint Table View 
You can visual the material constraints in the tabular view also. This helps you to export the data to 
excel. 
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Modifying purchase orders 

You can modify purchase orders that are past due. Purchase orders may be past due because the purchase order 

has arrived but has not yet been converted to quantity on hand; consequently, the Purchase table has not yet been 

updated. They may also be past due because they have not yet arrived. You can clean up this past-due purchase 

orders by selecting Decisions > Clean Up Past Due PO. The following dialog box appears: 

 

 
Material Planning 
Filter 

You cannot change the information in these fields. The buyer ID associated with the 
purchase order and priority decisions you made from the Material Planning Configuration 
display. 

  

Past Due PO Filter 
Part ID: 
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Past Due PO table 

The Past Due PO Table shows the following: 

 

The status indicates whether the purchase order is normal, new, split, or modified. When you right click on a line 

number, you can do the following: 

• Modify the purchase order. You can also do this by double-clicking with the left mouse button. 

• Add a new purchase order. 

• Delete an existing purchase order. 

• Split a purchase order. 

When this display appears, you can click on the table icon. The Material Supply/Demand table appears. You can also 

see this table by selecting Steps > Identify > Material Constraints. 

Part ID If you select a Part ID in this field, only the purchase order from that part will be searched 

Cut Off Date You can clean up data from this date backward. By default, this is the horizon start. Type in a date 
after horizon start to search purchase orders dated prior to the date you select. Thru-Put 
automatically pushes out purchase order due dates in the past to horizon start. 
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Material Supply/Demand table 

 
Date One of the following: 

 

Supply available The date the supply is available, derived from the  

Due_Date field in the Purchase table. 

Demand require The date the demand is required. Calculated by Thru-Put. 

  

Order-PO ID One of the following: 
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Supply The purchase order ID from the Purchase table. 
Appears in reverse mode; that is, black background 
with white text. 

Demand One of the following order IDs of the parent supply: 

 Sales 
 
Derived from the Order_ID field in the 
Sales table. 

 
Derived from the Forecast_ID in the 
Forecast table. 

 
 

  

Qty (Quantity) One of the following: 

Supply Derived from the Purchase table. 

Demand Calculated by Thru-Put. 
 

  

Proj Balance 
(Projected 
balance) 

The projected balance thus far, calculated by subtracted demand from supply. Appears in color 
based on the lateness of a supply/demand record. 

  

Line Number For supply, derived from the Line_Number field in the Purchase table. 

  

Product For demand, derived from the Part_ID fields of the parent supply: 

Sales Derived from the Sales table. 

Forecast Derived from the Forecast table. 
 

  

Target 
Completion 

For demand, derived from the target date of the parent supply: 

  

Projected 
Completion 

For demand, the projected completion date of the parent supply, either sales or forecast. 

  

Order Qty 
(Order 
Quantity) 

For demand, the net order quantity after considering forecast consumption and shipped order 
quantity. 
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Type For demand, the type of its parent supply, either sales or forecast. 

The table is sorted by date in ascending order. If the dates are the same, a special row for Minimum MRP Lead Time 

appears earlier, followed by a special row for Typical MRP Lead Time, followed by all normal rows. 

Minimum MRP Lead Time is defined as HS + Minimum MRP Lead Time, using the default calendar. Typical MRP 

Lead Time is defined as HS + Typical MRP Lead time, again using the default calendar. 

When you right click, a pop-up menu appears. You can do the following: 

• Select Edit Order to edit items in the demand row or to change the selected demand’s order due date. The 

Orders with Part Shortages table appears. 

• Select Edit PO to add, delete, modify, or split the supply PO row. The PO Modification table appears. 

• Select Push Order Out to push the selected demand’s order due date in order to have no material shortages. 

See “Pushing out choices” for more information. 

• Select Push All Orders Out to push out all related demand’s order due dates in order to have no material 

shortages. 

• Select Edit Lead Time to change the minimum MRP lead time. 

You can also select a single demand row and drag and drop it to a new destination. 

 

Orders with Part Shortages table 

Thru-Put detects orders with raw material shortages so you can take appropriate action when you select Orders with 

Material Shortages. 

Each order quantity appears in color to help you quickly comprehend quantities. You can accept projected completion 

dates for one or more orders, just as you can in the Materials Requirements profile. 

White  Sufficient quantity onhand for the order. 

Yellow Insufficient quantity onhand for the order, but quantity can be satisfied by available purchase orders. 

Red  Insufficient quantity onhand for the order and the quantity cannot be satisfied by available purchase orders. 

Double-click on an order item to see the required raw materials and any shortages. Double-click on a material item to 

see the supplies and demands for the item. 
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Not every raw material for a product part may appear. Any intermediate manufactured parts may satisfy the 

requirement for the immediate part. 

Double-clicking on a material item shows the supplies versus the demands for it. The colors in this window have 

different meanings. You can accept Projected Completion dates for one or more orders, just as you can in the 

Material Requirements Profile. 

When you select Decisions > Orders with Part Shortage, the following display appears: 

 

 
Order Number One of the following: 

Sales Derived from the Order_ID field in the Sales table. 

Forecast Derived from the Forecast_ID field in the Forecast table 
 

  

Product One of the following: 

Sales Derived from the Sales table. 

Forecast Derived from the Forecast table. 
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Target 
Completion 

One of the following: 

Sales Derived from the Promise_Date field in the Sales table. 

Forecast Derived from the Target_Date field in the Forecast table. 
 

  

Project 
Completion 

The order due date. 

  

Qty (Quantity) The net order quantity after Thru-Put considers forecast consumption and shipped 
order quantity. Appears in color based on the lateness of an order record. 

  

Type The type of the order’s parent supply, either sales or forecast. 

This table is sorted by promise date in ascending order. 

When you left click on any order record, the Single Order Material Shortage display appears. 

 

Single Order Material Shortage table 

This table lists all the raw material information for the selected order. 
Part ID Derived from the Part_ID field in the Part table. 

  

Qty Short (Quantity Short) The total quantity required of this raw material for this order. Appears in color 
based on lateness. 

  

Need Date The date this raw material and order are required. 

  

Available Date The date this raw material is available. 

  

Worst Lateness The worst possible delay. 

When you left double click on any raw material record, the Material Supply/Demand table appears again. 
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PO Modification table 

This table shows all firm purchase orders for the selected raw material. 

 

 
Order ID Derived from the Order_ID field in the Purchase table. 

Line Number Derived from the Line_Number field in the Purchase table. 

Due Date Derived from the Due_Date field in the Purchase table. 

Part_ID Derived from the Part_ID field in the Purchase table. 

Buyer ID Derived from the Buyer_ID field in the Purchase table. 

Vendor ID Derived from the Vendor_ID field in the Purchase table. 

Status Derived from the Status field in the Purchase table. 

This table is sorted in ascending order by part ID, due date, order ID, and line number. When you right click, a pop-up 

menu appears. You can do the following: 

• Modify: If you make no selection, Thru-Put uses the current purchase order. If you select a single row, Thru-Put 

uses the selected purchase order. The Purchase Order Modification dialog box appears. 
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You can only change the due date and order quantity. 

• Add: You can select a single row. The Purchase Order Addition dialog box appears. 

 
Order ID Type in an identifier for this new purchase order. The default is New PO. 
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Line Number Type in a line number for this new purchase order. The default is a sequence 
number beginning with 1. 

Part ID You cannot change the information in this field. It is based on the raw 
material from the Material Supply/Demand table. 

Due Date Type in a due date. The default is HS + Minimum MRP Lead Time. 

Order Qty (Order Quantity) Type in a quantity for this new purchase order. The default is zero. 

Buyer ID Type in a buyer for this new purchase order. The default is derived from the 
Buyer_ID field in the Part table. 

Vendor ID Type in a vendor for this new purchase order. The default is blank. 

• Delete: If you make no selection, Thru-Put deletes the current purchase order. If you select a single row, Thru-

Put deletes the selected purchase order. A warning message appears for you to confirm the deletion. 

• Split: If you make no selection, Thru-Put splits the current purchase order. If you select a single row, Thru-Put 

splits the selected purchase order. The Purchase Order Splitting Dialog box appears. 
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The upper half shows you the master purchase order information. 

No. of Splits (Number of Splits) Select a number from 2 to 10. The default is 2. 

New PO details (New purchase order details) The information appears in the following order, separated by 

commas: 

o Order ID 

o Line number 

o Due date 

o Order quantity 

o Buyer ID 
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o Vendor ID 

When you select a row and double click, the Purchase Order Split dialog appears. 

Purchase Order Split dialog. This dialog works as the Purchase Order Addition dialog does. All fields derive from 

fields in the Purchase table 
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Seeing past-due orders: Cacophony 

The Cacophony display shows you past-due orders on a single machine constraint that you have selected. Use it to 

see where you have placed load without capacity testing it. It shows the maximum number of units required to meet 

the orders you have in the system, as well as the available number of units. You can also see order details, job step 

details, and schedule details for the task you have selected. 

The load placement depends on the following: 

• Due date of the order 

• Location of the workcenter in the product structure 

• Size of the shipping buffer 

• Processing times on downstream operation 

 

Exploiting the constraint: Sync Harmony 

To facilitate decision making, several display options appropriate for finite scheduling are available. 

 
Option Description 

Tasks with Common Setup Highlights in light green all tasks on the drum with the same setup as the selected 
task. Lets you estimate the extent to which the load on the drum will be alleviated 
by running these tasks back-to-back. To select a task, select Display > Select 
Tasks With Common Setup. 

Tasks for Same Order All the tasks that belong to the same order as the selected task are highlighted in 
magenta. To select a task, select Display > Select Tasks For Same Order. Clicking 
on any other task will show the tasks for the same order. 

Tasks for the same shipping group All tasks within an order that share the same shipping group are highlighted. 

Tasks with Alternate Workcenter(s) Tasks that can be executed on other workcenters appear cyan. 

Tasks for Same Source 

The field in the Sales table that lets you determine 1 or 0. Use to prioritize customer 

orders in the Sales table. 1 appears yellow. 
Order Types Forecast requirements appear yellow and actual sales orders appear fluorescent 

blue. 

Unhilite This option removes the highlight from any tasks highlighted using any of the 
previous options. Select Display > Unhilite. 

Dependencies Select Display > Dependencies. This option is used to identify tasks on the drum 
that feed or are fed by the selected task. 
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Zoom In and Zoom Out Zoom in and out on the Harmony chart. 

Display TP$ Details See the profits-based effects of your drum scheduling decisions. 

Display TP$ on Cursor Move As you scroll through the harmony chart, see the TP $ (profit) details based on the 
current task. 

  

 

Harmony Grid 

You may find it easier to work with a table format than a Gantt chart. You can also make Harmony decisions using 

this table. You can see the table by selecting Session Results > Drum Schedules and selecting the current drum. You 

can also sort the grid by any column header. To sort by a specific column, click on the header for that column. 

The colors in the Harmony grid mean: 

• Red The customer or forecast order associated with that task will be delayed beyond its current completion 

date. 

• Green The customer or forecast order associated with the task is on-time. 

• White Idle capacity on the drum. 

The right-click menu in the Harmony grid appears in the drum schedule table. You can select group mode to select 

more than one work order at a time for offloading or other functions. You can also search for a specific order of the 

Harmony grid. What you do to the drum schedule table is reflected in the Harmony grid; however, not everything you 

do to the Harmony grid is reflected in the drum schedule table. 
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To select an order in the drum schedule table, click the number that appears in the table. To select more than one 

order in the drum schedule table, do one of the following. 

• Click one order followed by another while holding down the Control key 

• Click one order and then hold down the Shift key and click another order. All orders between the two orders will 

be selected. 

If you select a group of orders in the Harmony grid, Thru-Put preserves those orders if you then click orders in the 

drum schedule table. Once you move back to the Harmony grid from the drum schedule table, the selected orders 

are discarded. 

 

Drums 

Once you have identified a drum, you can schedule it by: 

1. Invoking Harmony by selecting Steps > Exploit > Harmony (Next) Drum. Alternatively, you can click on Harmony icon 

(see image below) from Thru-put toolbar displayed at the top. 
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It will ask you for Lookahead factor. If you already know what your lookahead factor is, you can specify that 

lookahead factor. 

 

 

See “Lookahead factors” for more information. Thru-Put generates an initial schedule for the drum. See “Initial drum 

schedule” for more information. 

 

 

2. Optimizing the schedule of the drum using various Harmony options such as: 

• Trading off setups 

http://localhost/tphelp/Modules/SyncEngine/Harmony.html#LookaheadFactors
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• Trading off batches 

• Offloading 

• Allocating overtime 

• Moving tasks manually 

Select Decisions > Undo Previous Actions if you are not happy with a decision. 

3. Adjusting the due dates. You can push out late orders and pull in orders that can be done earlier than the schedule 

reflects. 

 

 

If you have more than one drum, repeat these steps until all drums are scheduled. 

Initial drum schedule 

Once you have specified a lookahead factor, Thru-Put generates the initial schedule. As part of initial schedule 

generation, Thru-Put application performs detailed scheduling for all customer orders where it generates accurate 

material flow information along with exact scheduling of those orders on all drums assuming drums have finite 

capacity available and hence can’t be overloaded. In such scenarios, many of the customer orders end up getting 

pushed out. 
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During this schedule generation, the back-end algorithm first sorts all drum tasks by their LDB. On this sorted list, 

first backward scheduling is performed (i.e. right to left) where application starts from last task in the list and places 

it at its LDB; then schedules prior tasks to its left at their LDB or gap available earlier than LDB. Load distribution 

across units is also kept into consideration. 

Once backward scheduling is done, then application performs forward scheduling where it works on top of task 

sequence resulting from backward scheduling and schedules tasks from left to right. During forward scheduling, each 

task in the list is scheduled in the gap available at max(EST, LST - FwdScheduleLookback). Please 

note, FwdScheduleTaskLookback is a config flag which ensures drum tasks are not scheduled too early. 

FwdScheduleTaskLookback Flag 

This flag impacts both Initial Drum schedule as well as Setup saving action and indicates how soon we can start a 

task given the sales order is only required in next day, next week or next month. When the capacity is less or there 

are lots of load on the drum, this is not a big deal since they will be close to sales order any way. But when there is 

enough capacity, user may want to restrict how soon a task can be scheduled. For this we have a config.ini 

parameter called FwdScheduleTaskLookback = -1. Basically this parameter can be used to specify number of days 

from the latest start time in the backward direction. The task should not be scheduled earlier than this value. Suppose 

for example, a drum task is ideally required to be started at 12/15 10:00:00 hours at the latest, then if you specify 

FwdScheduleTaskLookback = 1, then it means Thru-Put should not schedule the task sooner than 12/14 10:00:00 

hours (assuming 24 hours working calendar). It can only schedule between 12/14 10:00 to 12/15 10:00. User can 

also specify this flag value in hours by appending 'H' which will deduct the specified hours from LST time to indicate 

the earliest time when a task can get started. 

 

Kindly note, this flag impacts only drum tasks scheduling and does not have any impact on non-drum tasks. Once 

you have the initial schedule, you can optimize it using the options described in this chapter. 

Interacting drums 

Interacting tasks are those tasks on either the same drum or different drums that feed each other. Before Thru-Put 

schedules a task, it first schedules all drum tasks that feed this task. Even if a task is within the lookahead duration, it 

might not get pulled in because there may be unscheduled tasks feeding this task. 

For example, two tasks (A and B) share a common setup. These tasks are close to each other after the drum has 

been backward scheduled. Task C is unscheduled either on the same drum or another drum and it feeds task B. 

Because task C is unscheduled, task B will not be pulled in or scheduled beside task A. 
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Tasks on the current drum may interact with tasks on previously scheduled drums or other tasks on the current drum. 

Thru-Put shows these interactions in the Schedule Details window of the Harmony display. Interactions are classified 

as: 

B Backward 

F Forward 

If a task from a drum feeds the current task, it is a backward interaction. If the current task feeds another drum task, it 

is a forward interaction. Only one forward interaction can exist; however, many backward interactions can exist. Thru-

Put shows you these interactions in the interaction string. You should identify at least one drum for each source of 

independent demand for each product group and yet, as much as possible, not identify multiple drums for the same 

source of independent demand. Especially avoid two drums in a single rope. 

or example, the interaction string F4B3B5B6 indicates the current task has a forward interaction with drum 4 (F4) and 

a backward interaction with drums 3, 5 and 6 (B3B5B6). 

Drum offset 

The difference between the time a task is originally placed on a drum and the time at which it is scheduled on the 

drum is the drum offset. Based on the capacity of other jobs, the time to perform a jobstep may change. Drum offset 

is the result of capacity shortages on the drum resulting in a level-loaded schedule. You can make setup savings 

decisions to add to the drum offset. 

 

Mix of Regular Harmony & Cacophony View 

Thru-Put application performs detailed scheduling for all customer orders where it generates accurate material flow 

information along with exact scheduling of those orders on all drums assuming drums have finite capacity available 

and hence can’t be overloaded. In such scenarios, many of the customer orders end up getting pushed out. 

But in many industries, customer would like to generate detailed schedule till a certain time period i.e. cut off period; 

and after that cut-off period, customer would instead like to assume infinite drum capacity availability and hence 

generate a high-level schedule where all drum tasks are scheduled simply by their LDB (i.e. latest due by) or cut-off 

period date whichever is maximum. This will prevent pushing out of customer orders falling outside that cut-off period 

date (unless their LDB is less than cut-off date) even if drum if heavily loaded; and hence will help generate an “ideal” 

schedule where material is released just in time and enough capacity is available on workcenters to process the 

orders. 
 

Implementation Details 
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The modified harmony view which will be a mix of regular harmony view (having finite capacity) from Horizon Start till 

Cut-Off period; and after the cut-off period, a cacophony view (having infinite capacity) will be displayed. So, the 

orders scheduled by harmony logic within the Cut-off period will get scheduled on drum using regular harmony logic; 

while the orders scheduled outside cutoff period will get scheduled simply at their LST (or CutOff date whichever is 

higher) irrespective if drum is having enough capacity available on that day or not. 

Let us take an example where we have below listed 5 Sales orders. Each 100 pieces takes 8 hours to process and 

we have a working calendar of 8 hours per day (from Mon-Fri). In other words, each of below order will assume take 

2 days to process. Here HorizonStart = 06/22/2018. 

 
Order_ID QTY Promise_Date LST 

 ORD001  200  06/25/2018  06/22/2018 00:00 

 ORD002  200  06/26/2018  06/25/2018 00:00 

 ORD003  200  07/03/2018  07/02/2018 00:00 

 ORD004  200  07/03/2018  07/02/2018 00:00 

 ORD005  200  07/04/2018  07/03/2018 00:00 

Regular Harmony View: If we use regular harmony logic to schedule above customer orders, then we will end up 

with a schedule as below where ORD002 and ORD005 will get late as those are ending at 06/27 08:00 and 07/05 

08:00 respectively. 
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Cacophony View: In this view, all orders will get placed at their LST on invisible units assuming drum is having 

infinite capacity available and no orders will get marked as late. 

 

Mix View: This screen will be a mix of above 2 screens – Regular Harmony View and Cacophony View; just with the 

difference that tasks which were placed within the CutOff period will get scheduled using regular harmony logic i.e. 

assuming drum is having finite capacity available; and tasks on or after Cut-off period will get scheduled using 

Cacophony logic i.e. assuming infinite capacity is available. 

 

So, here only ORD002 will get pushed out as its ending at 06/27 08:00 while its LDB is 06/26 08:00. 

Database Changes 

A new parameter named “HARMONY_CUTOFF_PERIOD” has been added to RESPARA table. Its default value will 

be 0 which indicates regular harmony logic will come into play. Only when this parameter value is positive i.e. > 0, 

that new feature will kick-in. 

Please note, HARMONY_CUTOFF_DAYS should always be greater than config 

parameter ResyncScheduleStabilityPeriodNoDays value (which denotes Frozen Zone); if user has set a positive 
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value (i.e. > 0) for HARMONY_CUTOFF_DAYS. This check is done during harmony session (in both SYNC and 

RESYNC). 

In other words, if HARMONY_CUTOFF_DAYS > 0 and HARMONY_CUTOFF_DAYS <= 

ResyncScheduleStabilityPeriodNoDays, then application will update it as HARMONY_CUTOFF_DAYS = 

ResyncScheduleStabilityPeriodNoDays + 1 and will also log the message to Import.log file. 
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SYNC and RESYNC Scheduling 

1. This logic will be available only for regular harmony (not for New Harmony) in both SYNC and RESYNC session in 

Version 1. 

  

2. In SYNC session, the regular harmony task scheduling logic will first generate a feasible schedule; but before plotting 

those tasks in UI, application will check if HARMONY_CUTOFF_PERIOD value is > 0. If so, then it will compute 

CutOff Date by adding this value to HorizonStart. All tasks which are scheduled to start earlier than this CutOff Date 

will get placed on actual units like regular harmony; and rest of the tasks i.e. tasks scheduled to start outside CutOff 

Date will be placed on virtual units like cacophony view. 

Here is an example of resulting SYNC harmony screenshot when HARMONY_CUTOFF_PERIOD=5 in RESPARA 

table. 

 
  

3. In SYNC session, this feature will also be supported for below actions: 

• Setup Saving: TradeOff 

• Manual Placement** 

• Place At LST** 

• Place At EST** 

• Manual Overtime 

• Automatic OverTime 
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**This new feature is supported for Manual Move of tasks only when ManualMove=2 in config.ini file. 

  

4. In RESYNC session, this mix view will get displayed only after Schedule New Tasks. If there are no new tasks in 

RESYNC, then application will check for CleanUp and Resolve Past Due actions; and after executing the last action 

(i.e. CleanUp or Resolve Past Due) only, this new feature will come into play. 

  

5. In RESYNC session, this feature will also be supported for below actions: 

• Setup Saving: TradeOff 

• Manual Placement** 

• Place At LST** 

• Place At EST** 

• Manual Overtime 

**This new feature is supported for Manual Move of tasks only when ManualMove=2 in config.ini file. 

  

6. Another import point to note here is that the tasks scheduled after CutOff Period using cacophony view will always 

have a valid unit # assigned; though in UI, those will get displayed on virtual units. 

  

Offloading 

Your drum may not have enough capacity to complete all orders on time. If you have an alternate workcenter to 

which you can offload some of the work from the drum, you can ease the load on the drum. Thru-Put allows you to 

offload tasks from the drum one at a time or as a group. You can use the offload option to offload some of your work 

to an outside vendor or subcontractor. You can declare your vendor or subcontractor as an alternate workcenter to 

whom you offload when you run short of capacity. 
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To offload a group of tasks together: 

1. Click the right mouse button and select Group Mode from the dialog box. 

2. Select the tasks to be offloaded by clicking on them or by pressing the space bar. The selected tasks’ colors turn 

gray. You can deselect a task by clicking it again or by pressing the space bar again. 

3. Click the right mouse button and select Offload from the dialog box. A dialog box appears with the list of alternate 

workcenters. 

4. Select a workcenter and proceed. Another dialog appears with a list of the tasks selected. You can edit the offload 

details by clicking on the task and clicking on the Edit button. All the tasks in the list get offloaded when you click OK. 
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Seeing information about offloaded tasks. To see tasks that have been offloaded in the current scheduling 

session, select Session Results > Offloaded Tasks. 

To see tasks offloaded in the previous scheduling session or after the schedules have been saved in the current 

session, select Reports > Offload List or DBMaint > Offloaded Tasks. 
 

Declaring Alternate Workcenters 

You can spontaneously define alternate workcenters for a part/job step when you decide to offload to a non-drum. To 

offload a task to an alternate workcenter: 

1. Highlight a task by left clicking on the task. 

2. Click the right mouse button. 

3. Select offload from the dialog box. A dialog box appears. 

4. Select the workcenter that is to be the target of the offload from the workcenter list and modify its routing details. 
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Saving Setups 

When Thru-Put generates the schedule on the drum, it schedules tasks in order to complete an order on time, but no 

sooner or later. (See the Concepts Guide for more information.) The sequence of tasks on a drum is driven by the 

due dates of the orders. 

By default, Thru-Put does not combine tasks with similar setups. 

• If tasks with similar setups are combined, some other tasks may be made late. For example, task A can be 

combined with task D to save a setup. Tasks B and C, originally scheduled between A and D, are more urgent 

than task D. If you move task D right after task A, tasks B and C might be late. 

• When you combine setups, you make a bigger batch of parts. To run a bigger batch on the drum, you will run a 

bigger batch on all upstream and downstream Workcenters. A bigger batch size leads to bigger queues in front 

of all Workcenters and eventually leads to longer lead times and mismanagement of resources. 

• Bigger batches result in more WIP and higher inventory cost. 

However, combining setups on the drum can save significant capacity on a drum. An hour saved on a drum can 

mean an hour of extra throughput. If your setup times are large, you may reduce the average lateness of tasks. By 

pulling in one task, you make other orders early. If these orders are running late, you reduce their lateness. 

Generally, a trade-off between saving setups and delivering customer orders on time exists. You can set these 

parameters during the implementation process. If the product mix does not change significantly, your options and 

parameters should not change significantly either. 

Thru-Put provides these options to save setups on drums. 
Option Description 

Lookahead factor Specify a lookahead factor and save setups within that range. 

Desired run percentage Looks at both setup and runtimes. Specifies a percent of time the drums 
should be running. 

Pure gains Thru-Put automatically saves setups as long as the timeliness of 
subsequent tasks is not affected. 

Trade-offs allow setup savings even if other tasks are pushed out. To save setups automatically, select Decisions > 

Save Setups: Pure Gains. Thru-Put shows you the number of hours of setup saved. 

 

Specify setup families 
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Thru-Put combines tasks on drums that share a common setup. You specify the information about common setups 

using major and minor family information in the routing records. When an operation from one setup family follows 

another operation from a different family, you incur a major setup (the setup). When one operation follows another 

operation within the same major family (the family) but a different minor family, you incur a minor setup 

Major setup  Specified in the Setup_Time field of the Routing table 

Minor setup  Specified in the Minor_Setup_Time field of the Routing table 

Family      Specified in the Family_ID field of the Routing table 

Minor family  Specified in the Minor_Family_ID field of the Routing table 

See the Concepts Guide for more information. 

Minor families. Often parts that belong to the same major family might still incur a minor setup when scheduled 

back-to-back on the same machine. These parts should be grouped within the same major family, but in different 

minor families. Minor setup time should be specified in the Routing file. 

Sequence 

You can set a sequence for parts within the same major family. You specify the sequence in the sequence-dependent 

setup file. When Thru-Put looks ahead, it sequences the tasks with the same major family in the sequence you 

established. See the Concepts Guide for more information. 

If you do not specify a family, Thru-Put assumes that routing records belong to different families. If you do not require 

any minor setups, leave the field empty. For example, you have part A in job step 10 (A/10) and part B in job step 10 

(B/10). If you instruct Thru-Put that both parts belong to the same family by using the same string in 

the Family_ID field of the two records, they share the same setup. Otherwise, they do not. 

If you do not specify a sub-family, parts within the same family belong to different subfamilies. For example, A/10 and 

B/10 belong to the same family only if you explicitly declare them to belong to same sub-family by using the same 

string for Minor_Family_ID. 

In the following example, two part/job steps share the same setup family so their setup time is the same. Operation 

Y/10 follows X/10. No setup is incurred for the Y/10 operation since both belong to family FM3. A/10 follows X/10. A 

setup of 7,200 seconds (2 hours) incurs because they belong to different families. 

Operation B/10 occurs after operation A/10. A minor setup time of 1,200 seconds (20 minutes) is required for 

operation B/10 because A/10 and B/10 belong to same family but different minor families (FM1_SUB1 and 

FM_SUB2). Operation B/10 does not incur the full setup of 7,200 seconds (2 hours); it incurs only a minor setup. 

Also, operations A/10 and B/10 share the same family or the minor family and minor setup time makes no sense. 
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Operation A/10 occurs after operation B/10. A minor setup time of 600 seconds (10 minutes) is required. Operation 

C/10 occurs after operation A/10. No minor setup is incurred because operations C/10 and A/10 share the 

same Family_ID and Minor_Family_ID. Operation D/10 follows E/10, so a minor setup is involved. 

 
Part/Job step Family_ID Setup_Time Minor_Family_ID Minor_Setup_Time 

X/10 FM3 10,000 
  

Y/10 FM3 10,000 
  

A/10 FM1 7,200 FM1_SUB1 600 

B/10 FM1 7,200 FM1_SUB2 1200 

C/10 FM1 7,200 FM1_SUB1 600 

D/10 FM2 8,000 
 

500 

E/10 FM2 8,000 
 

400 

 
Lookahead factors 

When the Harmony scheduling process begins, Thru-Put prompts you for a lookahead factor for the drum. This 

number specifies how far Thru-Put looks ahead to find similar tasks in order to save a setup. Thru-Put multiplies the 

number you enter by the amount of setup time for each task. The result is the amount of time after the task that Thru-

Put looks to find and group similar tasks. 

See the Concepts Guide for more information. 

Generally, a trade-off between saving setups and lateness/lead times exists. Saving setups increases the amount of 

work you finish at the drum, perhaps at the cost of an increased lead time and late customer orders. 

When a given operation has a long setup, it makes sense to make a bigger batch. If the setup time is small, it makes 

sense to keep the batch size small. The lookahead factor is a way of specifying this. 

Using the lookahead factor. To perform a lookahead setup trade-off, select Decisions > Save Setup: Tradeoffs. 
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There are few additional Lookahead options available too as listed below: 

• Limit Task Earliness From Required Time To: This field is auto-populated based upon 

the FwdScheduleTaskLookback config flag value. This flag controls too early scheduling of a task and 

indicates a task should not be scheduled any earlier than LST (Latest Start Date) - FwdScheduleTaskLookback 

value. By default, this value is specified is number of days. 

• Setup Saving CutOff: This value indicates Setup Saving will only pull-in tasks till Horizon Start + this value (in 

days) range. Any task beyond this date range will not be touched for setup saving. 

• Setup Saving Lateness Limit: This value indicates controls lateness of tasks which can possible result from 

Setup Saving action. If pull-in of a task to a datetime causes next task (scheduled on or after that datetime) to get 

late by more than this value, then it restricts pulling-in of that task. 

For example, a schedule generated before you do any lookahead tradeoffs may be that task A has a setup of two 

hours and is scheduled at time T (07/28 at 6:00). Task D shares the same setup and is scheduled at T+ 90 hours. 

Task F which shares the same setup and is scheduled at T+150 hours. If you perform a lookahead factor tradeoff 

with a lookahead factor of 50, Thru-Put looks ahead 100 (2*50) hours from task A to find similar tasks. Since task D is 

scheduled within these 100 hours (T+90), Thru-Put pulls task D next to task A. Task F is outside the lookahead time 

period of 100 (T+150) and is not pulled in. If task A had a setup of 1 hour, Thru-Put would have looked ahead only 50 

hours (1*50). Task B would not be pulled in. If Task A had a setup of four hours, Thru-Put would have looked ahead 

200 hours (4*50). Thru-Put would have pulled in both tasks D and F. 
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Limitations of lookahead factors. The setup time for a task and requirements for similar tasks within a certain time 

period determine tasks pulled into a lot. This time period is determined by the lookahead factor times the setup time 

for the task. This fails to provide a satisfactory solution in two conditions: 

• When the setup-to-runtime ratios vary widely among the job steps performed at the drum 

• When the volume requirements for the parts produced at the drum vary over a wide range. 

In these situations, some tasks have large setups and short runs and others have excessively large runs. Short 

runtimes indicate that the lookahead time is not long enough to pull in tasks that are farther away. If the lookahead 

factor is increased to pull in these tasks, tasks with longer runtimes are also pulled in, causing the intermediary tasks 

to be pushed out. This results in delayed tasks. See “Desired runtime percentage” for more information. 

Pure Gains 

When Thru-Put combines tasks with similar setups, interceding tasks are pushed out. For example, tasks A and D 

have the same setup. If task D is pulled in after task A, tasks B and C are pushed out by the runtime of task D. If 

pulling in task D does not make tasks B and C late, Thru-Put saves the setup. This can help improve the timeliness of 

the obs after D. For example, if tasks E and F are running late, they can be performed sooner. You can ask Thru-Put 

to automatically combine such setups using the Auto Save Setups option. Thru-Put determines if tasks can be 

scheduled back to back without turning green tasks into red or increasing the lateness of red tasks. 

Trade-Offs 
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Saving batches. If you have furnace-type workcenters that are drums, you can use the batch saving option to 

optimize the schedule of your drum. Thru-Put combines tasks that share a common batch. For example, part A/job 

step 10 (A/10) and part B/job step 10 (B/10) are batching operations. The batch size for the furnace-type operation is 

50. It takes the same amount of runtime to process 1 or 50 pieces on the furnacetype drum. If an order for A is for 60 

pieces and an order for B is for 40 pieces, Thru-Put combines batches and use only two batches to fulfill these two 

orders (60+40 = 2*50). Thru-Put provides two methods for saving batches: 

• Batch by Family ID. Use the Family_ID field to specify that two operations can be batched. The same field 

determines whether two operations share a common setup. Thru-Put assumes that two operations that share the 

same setup can also be batched. However, the following conditions must be true: 

o The runtime per batch must be the same 

o The setup time must be the same. 

 

Option Description 

Lookahead batching trade-off Look for the order to pull in. See “Lookahead factors” for more 
information. 

Auto saving batches Combines batches if the due dates of the orders associated with other 
tasks are not pushed out. 

Using allocation from a previous 
scheduling session 

Load the overtime schedule from the previous scheduling session. Only 
overtime scheduled for days within the current scheduling horizon is 
considered. 

• Batch by capacity. The Batch_Size field in the routing record specifies the batch size. For example, 

the Batch_Size is 50 and the Run_Time_Per_Batch is 3 hours. It takes 3 hours to process 50 pieces or less. 

If two different parts/job step operations are batched together and have a different Batch_Size, the proportion of 

capacity occupied is in proportion to the Batch_Size. 

For example, the Batch_Size for A/10 is 100 and B/10 is 50. Each piece of A occupies 1/100 of the batch 

capacity. Each piece of B occupies 1/50 of batch capacity. A batch of 50 A/10 and 25 B/10 fully occupies the 

batch capacity (1/100* 50) + (1/50*25)=1). 

  

http://localhost/tphelp/Modules/SyncEngine/Harmony.html#LookaheadFactors
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Desired Runtime Percentage 

Desired runtime percentage is based on both the setup and runtime, and overcomes the deficiencies of the 

lookahead factor. The lookahead factor feature considers only the setup time of a task. The lookahead factor 

provides good results when most tasks on the drum have similar setup and runtimes per piece. If the tasks have a 

wide spread of different setup and runtime characteristics, the runtime percentage factor provides better results. The 

desired runtime percentage looks at both the setup and runtime. 

Specify a desired runtime percentage; that is, specify the percentage of time the drum should spend running. For 

example, specify that the drum should spend 70 percent of its time running and 30 percent of its time doing setups. 

Unlike the lookahead factor, this method looks at both the setup time and the runtime. 

Using Desired Run Percentage. When you schedule a drum, select Decisions > Desired Run Percentage. A 

Runtime Desired dialog appears. Specify the following numbers: 

• Runtime (percent of capacity). The target runtime percentage you want. This input must be an integer value 

between 0 and 100. 

• Maximum LookAhead (Hrs). An upper limit on the duration for lookahead into the future to combine tasks with 

similar setups. See “Lookahead factors” for more information. 

The run percentage you input for the drum is achieved by targeting that run percentage for every task set up on the 

drum. Thru-Put combines tasks with similar setups until the cumulative runtime of the total lot is greater than or equal 

to the run percentage you selected. 

Situations may arise in which tasks that are far apart are combined into a single task resulting in displacement of all 

tasks between the two tasks. For example, two tasks, A and B, with similar setup are separated by a large time gap. 

A is scheduled before B. If B is combined with A, the tasks between A and B are pushed back by a duration equal to 

the runtime of B. The situation is further aggravated if B has a relatively large runtime. To avoid combining tasks that 

are very far apart, you can specify an upper limit on the task pull-in interval. 

For example, you have a part/job step with a setup time of 100 minutes and a runtime of 10 minutes per piece. The 

following is the schedule for the tasks with similar setups on a drum before setup savings are performed. 

Desired Run Percentage (in percent) 80 

Maximum Lookahead (in hours) 300 

http://localhost/tphelp/Modules/SyncEngine/Harmony.html#LookaheadFactors
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The run percentage for task 1 is 66.67 percent (200/300). Task 1 alone does not satisfy the desired run percentage. 

Since task 2 has a start time within the maximum lookahead, it can be combined with task 1. Combine tasks 1 and 

task 2 gives a the total runtime of 500 (200+300). The new run percentage is 83.33 percent (500/600). This value is 

greater than the desired amount, so no more tasks are pulled in at this point. 

The run percentage for task 3 is 75 percent (300/400). Task 3 alone does not satisfy the desired run percentage. 

Therefore, more tasks have to be pulled in. However, the time difference between tasks 3 and 4 is 375 (600-225). 

Since the time difference is greater than the maximum lookahead duration of 300, task 4 cannot be pulled in to 

combine with task 3. Therefore, task 3 is processed without any setup saving. 

The resulting run percentage is not likely to be equal to the value you specified. However, over the scheduling 

horizon, the resulting run percentage will be close to the desired value. In the preceding example, the individual 

percentages are 83.33 percent and 75 percent with an overall percentage of approximately 79 percent. 

Estimating the runtime percentage. The load on a drum is composed of runtime load and setup time load. The run 

percentage you enter depends on the characteristics of the load-to-capacity chart for that drum. In general, the 

runtime 

ercentages you enter must be high enough to complete all tasks within the horizon. If you use a high runtime 

percentage, the batch sizes will be larger with corresponding increases in lead time. The following examples highlight 

two possible scenarios and the runtime percentage to be used in each case. 

• Runtime is less than 100 percent. A load of 120 percent exists on the drum with a runtime of 80 percent and a 

setup time of 40 percent. To complete all the tasks within the scheduling horizon, at least 80 percent of the drum 

capacity must be spent on processing the demand. Therefore, desired run must be 80 percent. 

• Runtime percentage is greater than 100 percent. A load of 150 percent exists on the drum with a runtime of 110 

percent and a setup time of 40 percent. Specify a percentage close to but less than 100 percent for maximum 

setup savings. 

If you see a lot of red tasks on the Harmony chart, this option might not yield the best results. This option is not 

available for tasks that feed into previously identified drums. 
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Allocating Overtime 

If late tasks exist on your drum, you are jeopardizing your throughput. Exploit any possible overtime opportunities on 

the drum. Thru-Put provides three overtime allocation modes 
 

Option Description 

Automatic overtime allocation Automatically allocates overtime to eliminate or reduce the lateness of 
orders based on your overtime policies and the lateness of the orders based 
upon the calendar/resource association. 

Manual overtime allocation You specify the exact amounts of overtime for each calendar day, rather than 
work day. Thru-Put optimally reschedules the workcenter after overtime 
allocation for up to 24 work hours per day 

Use overtime allocations from a previous 
scheduling session 

Load the overtime schedule from the previous scheduling session. Only 
overtime scheduled for days within the current horizon is considered. 

 

Specifying your overtime policies 

You can specify your overtime policies by editing the calendar for the drum Workcenter. To edit the calendar, select 

DBMaint > Calendar -> Edit. You can specify the following policy parameters: 

• Maximum OT on a working day 

• Maximum OT on a non-working day 

• Maximum total OT for the week 

• Invoke Automatic Overtime Allocation. 

To specify overtime policy options, follow these steps: 

• Automatic overtime. To automatically allocate overtime, select Decisions > Overtime: Automatic. Thru-Put 

allocates overtime based on your OT policies. These numbers are for every unit (machine) within a workcenter. 

• Manually allocating overtime. To allocate overtime manually, select Decisions > Overtime: Manual. Thru-Put 

prompts you to specify the date range and amount of overtime to be applied for every workcenter unit in that date 

range. You can use this option when the overtime policies in the calendar cannot be followed during a particular 

planning session. Type in the minutes of overtime to allocate during each day of the range for each unit. 

You can also manually allocate overtime from the L:C display or from the Time Phased Load Profile display. 

When you select a workcenter, the Manual OT dialog box appears. Type in a from date and a to date and the 

overtime per day or unit. 
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• Loading existing overtime. To load existing overtime schedules, select Decisions > Load Existing OT Schedule. 

The overtime schedule generated in the last planning session is used. You can load existing overtime and add 

additional overtime, but you cannot remove overtime when you select this option. 

Manual Overtime (OT) allocation in Shift Calendar 

If late tasks exist on your drum, you are jeopardizing your throughput. In order to exploit any possible overtime 

opportunities on the drum. Thru-Put provides an overtime allocation Mode of “Manual OT” where you can specify the 

exact amounts of overtime for each work day. Thru-Put optimally reschedules the work-center after overtime 

allocation for up to 24 work hours per day. 

NOTE: Manual OT with Shift Calendar implementation differs from Manual OT with Regular Calendar as it makes use 

of Work Days instead of Calendar days. Also, if a unit is not working during a shift, then OT won’t get allocated 

during that shift. 

To allocate overtime manually, select Decisions > Overtime: Manual. Thru-Put prompts you to specify the date 

range and amount of overtime to be applied for every workcenter unit in that date range as shown below. 

 

 

You can use this option when the overtime policies in the calendar cannot be followed during a particular planning 

session. Type in the minutes of overtime to allocate during each day of the range for each unit. User also has the 
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provision to specify Overtime for specific Calendar days by clicking on “Custom” Radio button option; and specifying 

OT for the user-preferred dates. 

When user specifies OT Mins Per WC Unit for a given date in above dialog, application performs below steps: 

• Check if the date is a Holiday; if so, then ignore that date for OT allocation. 

• If it is not a Holiday, allocate OT by setting OT allocates as min (OT Mins Entered by user, 24*60 Mins - Max 

working Mins for that day). In other words, sum of OT Hours applied plus working hours on that date cannot 

be greater than 24 hours. This is set in OVERTIME table and can be viewed by checking Session Results -> 

Allocated OverTime 

• Once OverTime is allocated, then application reschedules the drum i.e. both forward and backward 

scheduling on the drum to result in optimal utilization of drum capacity and overtime allocated. 

Please note, OT allocation in Shift Calendar works slightly differently from Regular Calendars as it always makes use 

of work days and working shifts. 

Max OT Available for a Unit when using Shift Calendar with 2 Shifts working is: 

(Second Shift Start Time - First Shift End Time) if unit is working in first Shift + (31 hours (i.e. 7 AM next day) - 

Second Shift End Time) if unit is working in second shift. 

Let us consider some examples of OT allocation on a drum which is having 3 units. Of these, all 3 units work in First 

Shift (which runs from 7 AM to 3 PM) and only 1 unit works in Second Shift (which runs from 3:30 PM to 11:30 PM). 

In other words, each of the 2 shifts has 8 working hours i.e. total 16 working hours. This means a max of 8 hours of 

OT can be applied per Unit. 

Scenario 1: Allocate 8 Hours of OT Per Unit 
Unit 

# 
First Shift Second Shift OT Allocated in First Shift OT Allocated in Second Shift 

TOTAL 
OT 

1 7:00 AM – 3:00 
PM 

3:30 PM -11:30 
PM 

3:00 PM – 3:30 PM = 30 
Mins 

11:30 PM – 7:00 AM = 7 hours 30 
mins 

8 Hours 

2 7:00 AM – 3:00 
PM 

None 3:00 PM – 3:30 PM = 30 
Mins 

None 30 Mins 

2 7:00 AM – 3:00 
PM 

None 3:00 PM – 3:30 PM = 30 
Mins 

None 30 Mins 

Here total of 9 hours of OT is allocated across all 3 units with max 8 hours of OT allocated on first unit. 
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Scenario 2: Allocate 1 Hours of OT Per Unit 
Unit # First Shift Second Shift OT Allocated in First Shift OT Allocated in Second Shift TOTAL OT 

1 7:00 AM – 3:00 PM 3:30 PM -11:30 PM 3:00 PM – 3:30 PM = 30 Mins 11:30 PM – 12:00 AM = 30 mins 1 Hours 

2 7:00 AM – 3:00 PM None 3:00 PM – 3:30 PM = 30 Mins None 30 Mins 

2 7:00 AM – 3:00 PM None 3:00 PM – 3:30 PM = 30 Mins None 30 Mins 

Here total of 2 hours of OT is allocated across all 3 units with max 1 hour of OT allocated on first unit. 

Scenario 3: Allocate 6 Hours of OT Per Unit 
Unit 

# 
First Shift Second Shift OT Allocated in First Shift OT Allocated in Second Shift 

TOTAL 
OT 

1 7:00 AM – 3:00 
PM 

3:30 PM -11:30 
PM 

3:00 PM – 3:30 PM = 30 
Mins 

11:30 PM – 5:00 AM = 5 hours 30 
mins 

6 Hours 

2 7:00 AM – 3:00 
PM 

None 3:00 PM – 3:30 PM = 30 
Mins 

None 30 Mins 

2 7:00 AM – 3:00 
PM 

None 3:00 PM – 3:30 PM = 30 
Mins 

None 30 Mins 

Here total of 7 hours of OT is allocated across all 3 units with max 6 hours of OT allocated on first unit. 

Scenario 4: Allocate 10 Hours of OT Per Unit 
Unit 

# 
First Shift Second Shift OT Allocated in First Shift OT Allocated in Second Shift 

TOTAL 
OT 

1 7:00 AM – 3:00 
PM 

3:30 PM -11:30 
PM 

3:00 PM – 3:30 PM = 30 
Mins 

11:30 PM – 7:00 AM = 7 hours 30 
mins 

8 Hours 

2 7:00 AM – 3:00 
PM 

None 3:00 PM – 3:30 PM = 30 
Mins 

None 30 Mins 

2 7:00 AM – 3:00 
PM 

None 3:00 PM – 3:30 PM = 30 
Mins 

None 30 Mins 

Here total of 9 hours of OT is allocated across all 3 units with max 8 hours of OT allocated on first unit. 
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Seeing allocated overtime 

To see the overtime allocated in the current scheduling session, select Session Result > Allocated Overtime. 

To see overtime allocated in the previous scheduling session or after the schedules have been saved in the current 

session, select Reports > Planned Overtime List or DBMaint > Overtime. 

 

Manually placing tasks 

Thru-Put lets you move a task manually to allow the schedule to take advantage of your manual placement. Thru-Put 

schedules the drum again after your manual placement. To move a task from one place in the schedule to another: 

1. Select the task you want to move by left-clicking the task. 

2. Hold the left button down and drag the task to the desired location. 

3. Drop the task by letting the left button up. The Manual Placement dialog box appears. You can edit the: 

• Start date. 

• Start time 

• Unit number for the task. 

A description of the earliest start time and latest start time information fields follows. See the Concepts Guide for 

more information. 

• Earliest Start Time. Every task on the drum has an Earliest Start Time caused by one or more of the following: 

o Processing and queue times on upstream workcenters for the task. 

o Tasks on previously scheduled drums or on this drum which feeds the task. 

o The presence of a hard material constraint. 

• Latest Start Time. Some tasks on the drum have a latest start time because the task feeds a task on a 

previously scheduled drum or on this drum. You must start the task by the specified time so you do not “starve” 

the drum. 

Multiple manual moves 

You can select and move multiple tasks together to a single place in the schedule. The sequence in which these 

tasks are placed is based on the sequence in which you selected them. If EST violations occur for some tasks, you 

can override the EST in a table format, or drop the task with the EST violation. 

Group Manual Move 
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Quite often when user needs to move around tasks belonging to same family/setup together on same unit or around 

same time, then they highlight all tasks with common family/setup; and click on Select Highlighted Tasks and then 

perform Manual Placement. This brings up a Group Manual Move dialog which lists all those highlighted tasks. From 

this dialog, user can manually move all tasks with one click or can selectively choose tasks which he would like to 

move around. 

By default, when Group Manual Move dialog appears, then all records will be CHECKED for manual move as shown 

below: 

 

 

User can selectively choose tasks in this dialog by CHECKING or UNCHECKING the checkboxes against each row 

for manual placement. There is also an Edit Details button, on click of which, user can edit New Start Date and New 

Unit details for individual tasks. Else if user wants all tasks to move to same unit and want back-to-back scheduled, 

then he can provide Unit and Schedule Start inputs boxes displayed. Once user hits OK, application will only move 

those tasks for which checkbox is CHECKED. 

 

Efficiency Override 

In Assembly Line Scheduling, Thru-Put combines multiple assembly lines with different capabilities, different 

calendars into one group and schedule them all together in one go and optimally allocate the tasks to their preferred 

assembly lines followed by next preferred lines until all assembly lines have been fully scheduled. The tasks 

scheduled for a given item can have multiple assembly lines (defined in a sequence just like Preferred Unit) defined 

for same operation but with different run time in ROUTE table. E.g. a task might take 15 mins to process on first 

preferred assembly line UA003; 20 mins on second preferred assembly line UA005 and 30 mins on probably third 

preferred assembly line UA006. 

With Efficiency Override feature, user can dynamically update run time of a selected task in harmony for Assembly 

lines, without impacting run time of other tasks for same item. E.g. If a task is having run time of 60 seconds and user 

provides an Efficiency Percentage value of 90 in UI; then Run time of task will get updated as: 
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Run Time = 60*100/90 = 6000/90 = 66.67 seconds 

Note: Efficiency Percentage specified by user should always be greater than zero. 

This feature is available for both Regular Harmony and for Assembly Line Scheduling. 
 

Workcenter Maintenance 

In Thru-Put, users have the option to define the downtime of a particular unit for any drum. To enter downtime record, 

please click DB Maint -> Workcenter Maintanence. It will display below screen where user can define the 

maintenance i.e. downtime for a given workcenter, its unit number, the start time and end time of maintenance time. 

 

 

As an example, above maintenance record indicates Thru-Put should not schedule any task between 06/28/2023 

01:00 - 06/29 2023 02:00 for MLG11X for its second unit when this drum i.e. MLG11X is harmonized as shown 

below. In harmony, the black colored blocks indicate Maintenance records. Please note, the maintenance can ONLY 

be defined for DRUMS. 
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Please note, once user declares maintenance record in Workcenter Maintenance; then user needs to exit out of Thru-

Put and reload the project to see the impact. 

Having said that, in lot of customer scenarios, especially in Assembly Line Scheduling, while harmonizing a drum, 

planner is informed about downtime for a given line which means no task should get scheduled for that date on the 

given line/unit. To handle this, the planner needs to either perform a lot of Manual Moves or he needs to close the 

Sync Engine, enter maintenance record that line, load project again and then re-plan out drums schedule which can 

be quite a time-consuming task. To help out planners in such scenarios, Thru-Put engine also has the ability to turn a 

given line on/off inside scheduling screen (e.g. adjust units for 1 day if they are going to turn a line off on a specific 

day). 

For this, a new menu option named “Define Maint..” has been added in harmony as shown below: 
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Once the user clicks on this menu option, the dialog below will pop-up. By default, it will show Start Date, End Date, 

Unit# (i.e. Machine) based upon current selected task sched start, sched end and Unit# respectively. Users can 

change the values as they would like to and can then click on OK. 
 

 

This will create a Maintenance record, will add to resource Maintenance Array. And then drum will get rescheduled 

automatically and harmony replotted. The defined maintenance will then get plotted automatically as shown below: 
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Users can also perform UNDO for this action. Along with this, once user performs WSP, then all new added 

Maintenance records during Harmony will get written back to WKCTR_MAINT table so that during next run, 

application can automatically pick the maintenance days for a given line and doesn’t schedule tasks on those dates. 

This feature is available for both Regular drums as well as for Assembly Line Scheduling. For Assembly Line, the 

Define Maintenance dialog will look like below where user can select multiple units/lines and can turn those off in one 

go. 
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Vertical Zooming in Harmony 

In Thru-Put harmony screen, we have zoom-in and zoom-out feature. But this feature works to perform only 

horizontal zooming. When there are lot of units (such as in Assembly Line Scheduling), it is often requested to have 

to vertical zoom-in and zoom-out option available too. 

To meet this requirement, we have now added 2 additional icons in harmony toolbar. Clicking on “Zoom Into Chart 

Vertically” will vertically zoom into the chart as shown below. Similarly, clicking on “Zoom Out of Chart Vertically” will 

vertically zoom out of the chart. 
 

 

 

Pushing Out Late Orders 

Pushing late orders out is typically the last viable option. Existence of red tasks on the Harmony screen indicates late 

orders. 

Thru-Put computes the latest due by (LDB) for every task on the drum. It may not be possible to schedule a task to its 

LDB due to capacity or EST constraints. If a task cannot be scheduled by its LDB and the task feeds the shipping 

buffer, Thru-Put tolerates a lateness of half a shipping buffer (Static Buffer). If the task feeds a task on another drum, 

Thru-Put does not tolerate any lateness beyond the LDB. 
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All late tasks are marked in red and must be resolved before you can move on. Thru-Put lets you push out individual 

orders or all late orders. 

Pushing out a specific order 

To push out a specific order: 

1. Select a task for the specific order by left-clicking the task. A dialog box appears. 

2. Right-click and select Push Order Due Date Out. Thru-Put pushes out the order by the minimum possible amount. 
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Pushing out all late orders 

To push out all late orders: 

1. Select Decisions > Push All Late Orders Out. 

2. Thru-Put warns you that you will not be able to undo this decision. Select Yes if you still want to push out the due 

dates. All tasks on the Harmony screen turn green. 
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Listing late orders 

To see the list of late orders that need to be pushed out, select Session Results > Which Orders To push Out?. A list 

of all orders to be pushed out on the current drum appears. 

To see the list of orders that have been pushed out in the current scheduling session, select Session Results > List of 

Orders Pushed Out. All orders that have been pushed out appear on this list, not just the pushed out orders on the 

current drum. 

 

Undo 

Thru-Put lets you undo previous harmony actions so you can perform “what ifs”. For example, you can experiment 

with different lookahead factors to arrive at an optimal number. 

To undo a task, do the following: 

1. Select Decisions > Undo Previous Actions. 

2. Thru-Put shows you a list of scheduling actions taken on the current drum in the current session. 

3. Highlight the action to which you want to backtrack and click OK. The action you highlight and all other actions after 

that are undone. 

This option is not available after selecting Decisions > Push All Late Orders Out. 
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Jobs in progress 

The WIP information downloaded to Thru-Put specifies the quantity already processed at a particular part/job step. To 

specify a given quantity currently in progress on the drum workcenter, download jobs in progress (JIP) information. 

This is useful when tasks in progress are almost complete and will not take the full runtime. For example, an 

operation is 14 days long. It is in day 12. When you schedule such a workcenter as a drum, specify JIP on this drum. 

Similarly, if your setup times are long and you have finished most of the setup, use the JIP feature to specify the 

remaining setup time. If your setup is three days and you are already two days through your setup on the drum, 

specify this in JIP data. 

Specifying jobs in progress 

Download Jobs in Progress information using DBUtil or by editing the Jobs in Progress database table in DBMaint. 

The fields in this table are as follows: 
 

WORK_O
RDER_ID 

PAR
T_ID 

JOB_ST
EP_ID 

WORKCE
NTER_ID 

WORKCEN
TER_UNIT 

QTY_IN_P
ROCESS 

SETUP_TIME_
REMAINING 

RUN_TIME_R
EMAINING 

LOCATI
ON_ID 

         
 

When you specify JIP, keep the following in mind: 

• The Part_ID/Job_Step_ID/WorkCenter_ID must exist in a valid routing records. If you have already completed 

the setup for the current job, Setup_Remaining should be 0 and the Run_Remaining will specify the runtime 

remaining. 

• If Setup_Remaining is specified, the Run_Remaining field is ignored. The Qty_In_Process should be less than or 

equal to the Batch_Size for the corresponding routing record. 

 

Importing jobs in progress through DBUtil 

To import jobs in progress using DBUtil, do the following: 

1. Select DBUtil > File > Modify Config and specify the JIP file under Jobs in Progress. 

2. Prepare the FMT file (JIP.FMT) in DBUtil using Prepare FMT File. 

3. Build the database using DBUtil > File > Build Database. When you enter Thru-Put, it automatically reads the JIP 

database. 
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Jobs in progress display. Thru-Put creates tasks as specified in the JIP database. It pegs these tasks to orders that 

require the parts in progress. On the Harmony display, jobs in progress are indicated in the Schedule Details window. 

It appears as: 

Start Time mm/dd/yyyy hh:mm (in progress) 

End time mm/dd/yyyy hh:mm 
 

Drum Constraints Switching 

Constraints are anything that prevents the system from achieving its goal. There are many ways that constraints can 

show up, but a core principle within TOC is that there are not tens or hundreds of constraints but at most only a few in 

any given system. Constraints can be internal or external to the system. 

Internal constraints: 

• Equipment: The way equipment is currently used limits the ability of the system to produce more salable 

goods/services. 

• People: Lack of skilled people limits the system. Mental models held by people can cause behavior that 

becomes a constraint. 

• Policy: A written or unwritten policy prevents the system from making more. 

Please note: organizations have many problems with equipment, people, policies, etc. (A breakdown is just that – a 

breakdown – and is not a constraint in the true sense of the TOC concept). The constraint is the limiting factor that is 

preventing the organization from getting more throughput (typically, revenue through sales) even when nothing goes 

wrong. 

In manufacturing processes, constraints are often referred to as bottlenecks. ... For example, the belief that “we 

must always keep our equipment running to lower the manufacturing cost per piece. In other words we can say that 

a system/facility that is heavily loaded can declare as drum constraint. 

The idea behind drum constraints switching is interchanging the position of facility/resources in the list 

where more backward dependency exists. Initially Drum constraints are declared according to Load vs capacity. 

The facility/Resource which is heavily loaded is defined 1st drum and so on… 

At the time of drum (constraint) declaration we have not measured task’s interactions because we don’t have the 

sufficient information. When a current drum task is feed by either next drum task or successive of next drum task is 

called backward interaction. When we are in the harmony window and one/more backward interactions are exists 

between current drum tasks with either next drum tasks or successive of next drum tasks then we can interchange 

the current drum position with either next drum position or successive of next drum position from the displayed drum 

constraints list on the dialog. This feature is available from the popup menu “Switch the current Drum to…” 
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option in harmony window . By this way we can reduce the task’s backward dependency and we may optimize the 

out output schedules by utilizing resources in a right way. This feature is available in both Sync/ReSync modules. 

Let’s understand this feature by an example from sample database: 
 

 

The above selected task from harmony window for the part “IMPHC10” for the qty 76 is forward interacted with drum 

No. 4 and backward interacted with drum No. 5. By selecting “Switch the Current Drum to…” option from popup menu 

we can interchange current drum with Drum no. 5 and we can remove this backward interaction. 

When user will click this menu option a dialog will be appeared as below: 
 

 

After drum constraint selection from the list when user will hit OK button then this Drum Switching action will be 

performed (Current drum “MLG11X” will be placed at “FRG130” i.e. 5th index). 



THRU-PUT Advanced Planning and Scheduling User Guide  

  
Infor Confidential- Please do not distribute Page 102 

Limitations: 

This option will not be available if user has performed “Push all orders out” action in current harmony window. 

 

Reviewing schedule status 

You can review the status of your scheduling decisions any time in Harmony. The available views are: 

 

• Drum Schedule. Use this option to review the schedule for drums for which there are some existing schedules. 

You can see unscheduled drums on this list if they are downstream of the drum currently being scheduled. The 

software schedules the feeding task before it schedules the downstream tasks to ensure schedule feasibility. 
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 Fig. : Before Drum Schedule 

• Allocated Overtime. See the overtime allocated so far to all scheduled drums. The numbers indicate overtime 

per machine unit of the workcenter. 

• Offloaded Tasks. See any offloading decisions you have taken so far. 

• Which Orders to Push Out. See if the decisions you are making are helping you generate a better schedule. 

You can sort this table by any column. 

• List of order(s) pushed out. See the orders you have pushed out due to conflicts at previous constraints. 

• List of order(s) pulled in. See the orders whose due dates you have pulled in to ship them early. Orders can be 

pulled in only after all drums have been scheduled. 

• Display Unit/Line Summary. Customer requested for a new feature in ThruPut which displays summarized view 

of drum schedule by Unit/Line further grouped by different items listing # of pcs/day by unit and also display load 

hours/capacity hours. This will quickly help them to view which items are causing max load on a given day on a 

given line and is immensely helpful for Assembly Line Scheduling. 

To meet this requirement, we have added a new menu option named “Unit/Assy Line Summary” under Session 

Results. Clicking on this new menu option will display below kind of screen for Assy Line resource where you can 

see Drum Schedule data grouped by Sched Start Date, Line/Unit# and Part ID; and displaying total load and qty 

for each such group. This screen is, by default, sorted on the basis of Sched Date, Unit # and Part ID. 
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Similarly, for regular workcenter, it will display data as shown below: 

 

 

You can print any of these grids. When you see the Gantt chart, some load to capacity information appears at the 

bottom of the screen. On the grid, the following appear: 
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• The total load for all the open orders downloaded with the horizon end based on the last open order or forecast 

downloaded. 

• The split of this load between setups and runtime updated by your setup saving decisions. 

• The capacity of this workcenter with horizon at the top of the screen. 

• The overtime capacity added so far. 

 

Review Drum schedule before WSP 

In assembly line scenario, we have different supervisors responsible for separating the assembly lines. Each 

Supervisor knows downtime/uptime and corresponding schedule of each line. The planner running the sync engine 

tries to plan the best schedule for each assembly line; but often the planner is not completely aware of each 

assembly line actual schedule and its downtime which may cause in incorrect/invalid schedule at times. So, we have 

introduced a safeguard measure in Thru-Put to send drum schedule for review over email to supervisors before 

freezing i.e. writing the schedule. 

This feature is available in Harmony screen under Session Results and is named as “Email Current Drum Schedule”. 

Once planner harmonizes a drum and performs all needed action (such as setup saving, manual move), he can click 

on “Email Current Drum Schedule” menu option which will send current drum schedule by e-mail to assembly line 

supervisors for review. Line supervisors can review the schedule and if any correction is required, they can provide 

their suggestions to take correct actions timely 

Below listed is one time setup needed in config.ini to configure email settings for this feature. 

Under [Server Options] section in config.ini file need to give parameter values: 

MailServer=<SMTP mail server> → SMTP Server Name which is configured on Thru-Put server 

MailSubject=<Subject of e-mail> → This is optional. If left empty, then default subject will be “Drum schedule 

Report for <Drum name>” 

MailFrom=<Sender e-mail address> → E-mail address thru which e-mail will be sent. 

DrumScheduleApproverEmail=<Recipient e-mail address> → We can give multiple recipients separated by semi 

colon. 

 

Seeing the request and promise dates on the Harmony display 

You can see the customer request and original promise (first capacity-tested due date) dates committed to the 

customer on the Harmony display. 
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The initial schedule appears as a Gantt chart, with time on the X axis and number of units on the Y axis. You can see 

the charts as a table by clicking the table icon. In the Harmony chart, tasks are color coded as follows: 

 

Green    Tasks can be completed on time 

Red   Tasks are late and will cause late delivery of an order 

Blue   Highlighted task 

The top area of the chart shows the following for the selected task: 

• Order details 

• Job step details 

• Schedule details. 

The bottom area of the chart shows a status bar for the following: 

• Total capacity in hours (regular and overtime) 

• Total load in hours 

• Percentages of runtime 

• Setup time to total load. 

For each task selected from the Gantt chart, the top of the window shows the: 

• Independent demand driving the requirement 

• Job step level details for the task 

• Schedule details for the task. 

See “Initial drum schedule” for more information. 

To print the chart, select File > Print. The Bar-Chart Print dialog box appears. Select the bar at which you want to 

start printing and the number of bars you want to print. Set your printer default for landscape printing as Thru-Put 

uses the printer default. 
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After using the Thru-Put Synchronization engine in Thru-Put, you will have generated a Planned Work Orders 

Schedule. These orders minimize inventory on the shop floor and maximize the throughput of the plant. 

After you have identified drums, Thru-Put optimally schedules those drums based on their finite capacity. The 

purpose of exploiting the constraints, or drums, is to maximize profit, minimize the number of late orders, minimize 

the lateness of the most late orders through the drum, and minimize dollar date lateness. You can: 

• Perform setup saving trade-offs to optimize the setup times 

• Perform batch saving trade-offs for furnace type operations 

• Offload tasks to alternate Workcenters, if available 

• Automatically allocate overtime or allocate it by your specifications 

• Manually move tasks, changing their place in the schedule 

• Push out late orders and pull in early orders 

• Undo previous Harmony decisions so you can engage strategy planning and compare the results of various 

decisions on scheduling. 
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Resynchronization 
Resynchronization incrementally updates your plans. It updates the buffer status of existing orders and drum 

schedules. This contrasts with the Synchronization process which ignores the old plan and starts fresh. 

• You can see changes in demand from previous planning sessions for closed, new, or changed orders. 

• You can see changes for closed, new, or changed purchase orders 

• You can see work that was performed on constrained workcenters 

• You can see the impact of these changes on load to capacity and check the material availability 

Because Resynchronization starts with the existing plan, it provides stability in the planning process. You should use 

Resynchronization frequently, and in most environments, daily. You should Synchronization less frequently, and then 

only if the plans obtained by Resynchronization are unsatisfactory. 

Resynchronization matches demand with previous demand using DBUtil. It factors out minor changes in the demand. 

For example, a customer order is pulled in by one day, causing one day of shipping buffer penetration. 

Resynchronization updates the shipping buffer penetration of this order. Resynchronization accounts for order 

modifications. New orders get added to the plan. Cancelled orders are deleted from the plan. Resynchronization then 

updates the plan. 

1. It updates the drum schedule. If required, it modifies the order due dates. Thru-Put schedules are derived from drum 

schedules and the due dates of the orders. 

2. Once these schedules have been updated, Thru-Put updates other schedules, which include: 

• Planned work orders 

• Planned purchase orders 

• Exception messages for open work orders 

• Open purchase orders (buffer management). 

Analyze buffers 

Drum-Buffer-Rope includes strategic buffers to ensure that plans are stable and can be executed despite Murphy and 

variability. When you manage the drum, shipping, and assembly buffers, you must constantly and properly plan. 

Resynchronization handles buffer management. When you resynchronize, you update the buffer penetration status 

for each order, drum task, and buffered assembly. 
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Automatic Resynchronization 

Use the Analyze Buffer Option in Resynchronization to start automatic Resynchronization. This process incrementally 

updates the existing plan with no user intervention, and attempts to maintain as much of the old drum schedule as 

possible. 
Automatic Resynchronization does not ensure that the drum is capacity tested. This should not cause problems, 
however, unless one of the following is true: 

• You are not following drum schedules. For example, Thru-Put asks you to work on part A yesterday and part B 

on the current day, and you did not finish part A on the previous day, Thru-Put asks you to work on parts A and B 

now. If you did part B instead of part A on the previous day, Thru-Put asks you to do part A today. 

• You did not capacity test a new order. All new orders should be capacity tested. If a new order is not capacity 

tested, Thru-Put updates the drum schedule to accommodate the task without testing for capacity. Because 

drum schedules are capacity tested, the new schedules should work. 

To be sure that new schedules are capacity tested, you can use the manual Resynchronization process. 

Manual Resynchronization 

Manual Resynchronization is similar to Synchronization. Drums are scheduled using Synchronization, and then 

subordination is performed with Resynchronization. The key differences between Synchronization and manual 

Resynchronization are as follows: 

• Manual Resynchronization assumes that the drums have not changed since the last Synchronization or 

Resynchronization session. This is usually true unless demand or capacity has dramatically changed, which 

happens if an existing constraint has been elevated. 

• Manual Resynchronization performs automatic Resynchronization on drums first. The existing plan is used as a 

starting point. 

Resynchronization Engine incrementally updates plans to account for day-to-day changes. Resynchronization works 

like NetGen MRP to analyze all system fluctuations and filters out those anomalies that will be absorbed by strategic 

time buffers. By concept of frozen scheduling zone, user can see daily summary of tasks completions and changes 

and make appropriate decisions to keep order delivery schedule on track. New schedules are incrementally worked 

into the system and result in an updated master plan, production schedule and purchasing requirements. This will 

help you to retain stable schedule in the short term while being flexible to the changes in supply-demand picture in 

the longer horizon. 
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Resynchronization helps schedulers to define frozen schedules while looking for empty slots in the schedule to take 

up tasks to meet incoming new customers. 

There are 3 steps involved in ReSync to incorporate New Schedules: Cleanup, Resolve Past Dues and Schedule 

New Tasks. All these 3 steps are accessible on right-clicking in ReSync harmony chart. 

• Clean Up: By default, when we are in ReSync harmony, the existing old schedule i.e. Schedule From Previous 

Session might also list some cancelled tasks. To remove those from schedule, user first needs to perform 

Cleanup. 

 

• Resolve Past Dues: It is quite possible that some of the old tasks i.e. tasks from Previous Session are 

scheduled in the past i.e. earlier than Horizon Start. Performing Resolve Past Dues will push those past due 

tasks (and the tasks in front of those) to a date time on or after Horizon Start. 

 

• Schedule New Tasks: This is main step which schedules all New Tasks in the gaps available in existing 

schedule. While looking for gaps, it only checks for gaps on or after Frozen Zone. There are different logic written 

to schedule new tasks depending upon multiple criterias such as: a) Priority of New Tasks Vs Old Tasks b) 

Interaction between drums c) Better Optimization of Drum Capacity etc. 

 

The RESPARA parameter STABILITY_WITH_NEWTASKS governs which logic will be used for Schedule New 

Tasks. This parameter value can be changed dynamically from the engine and user can try out resulting 
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schedule with different values and adopt the one which better suits their requirements. Please refer 

to RESPARA_PARAMETERS.docx for complete details on this parameter values. 

Just like in Synchronization module, in ReSync too, we have multiple actions/features such as Setup Saving, Manual 

Placement, Offloading a task, Overtime Allocation and Push out This/All Orders available to better exploit the drum 

capacity and to minimize late tasks. You can find those when you right-click in ReSync Harmony chart as shown 

below: 

 

 

The same can also be accessed from Decisions menu. 
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Reviewing Schedule Status 

Just like in Sync session, In RESYNC too, you can review the status of your scheduling decisions any time in 

Harmony. The available views are: 

 

 

• Drum Schedule. Use this option to review the schedule for drums for which there are some existing schedules. 

You can see unscheduled drums on this list if they are downstream of the drum currently being scheduled. The 

software schedules the feeding task before it schedules the downstream tasks to ensure schedule feasibility. 
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 Fig. : Tabular Drum Schedule 

• Allocated Overtime. See the overtime allocated so far to all scheduled drums. The numbers indicate overtime per 

machine unit of the workcenter. 

• Offloaded Tasks. See any offloading decisions you have taken so far. 

• Which Orders to Push Out. See if the decisions you are making are helping you generate a better schedule. You 

can sort this table by any column. 

• List of order(s) pushed out. See the orders you have pushed out due to conflicts at previous constraints. 

• List of order(s) pulled in. See the orders whose due dates you have pulled in to ship them early. Orders can be 

pulled in only after all drums have been scheduled. 

 

Subordinating non-constraints: Subordination 

Subordination is the process of subordinating non-drums’ schedules and material release dates to drum schedules. 

Two tools perform this process: 

• Verify Protective Capacity Pass validates rope lengths and drums that have been modeled 

• Write Schedule Pass writes shop floor schedules and purchase material requirements. 
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Verify Protective Capacity Pass: Dynamic Rope 
Subordination 

Verify Protective Capacity Pass verifies the shop-floor model and the protective capacity you established. When you 

use this tool, Thru-Put considers the capacity of nondrums and dynamically computes their queue times. Non-drums 

may have excess capacity over the scheduling horizon but may still be overloaded on particular days causing jobs to 

wait in queues. Verify Protective Capacity Pass schedules backward to dynamically compute queue times based on 

your workload. 

Verify Protective Capacity Pass looks at the effective capacity available on the drum. Effective capacity is Total 

capacity minus Protective capacity. See “Protective Capacity” for more information. When you use Verify Protective 

Capacity Pass, Thru-Put uses Murphy buffers. The queue buffers are the expected queues at non-drums and are 

dynamically calculated by the Verify Protective Capacity Pass algorithm. See the Concepts Guide for more 

information. 

Verify Protective Capacity Pass back schedules drum schedules and projected completion dates of orders through 

non-drum workcenters. At each non-drum workcenter, work that cannot be completed on a given day is pushed back 

into the previous day. If you have sufficient capacity on the non-drums and you have set the buffer sizes correctly, 

you should see no overloads at the end of this process. Otherwise, there are problems with the model. 

There are two types of overloads: 
 

First Day Load The load on the first day, or horizon start, is greater than the capacity available to 
satisfy the load. A First Day Load (FDL) occurs when a task must be performed on the 
current day, the horizon start date, and insufficient capacity is available. 

For example, a drum operation is scheduled on August 7 and the horizon start is July 

31. Based on the temporary load on workcenters W1/W2/W3/W4, overloads occur on 

W1 on July 31 with 30 hours of required capacity and 16 hours of capacity available. 

See “Resolving overloads” for more information.  
Red Lane Peak conflict between a firm schedule date, or drum schedule, and the shipping schedule 

represented by the projected completion dates of independent demand orders exists. A 
Red Lane Peak (RLP) occurs when a task has a back wall at a drum but one of the 
downstream operations needs to be done before the back wall. 

For example, an order is due on August 15 and is scheduled on the drum on August 7. 

All downstream operations must be completed after August 7. Verify Protective 

Capacity Pass backward schedules. Non-drum W7 is temporarily overloaded, so Thru-

Put requests that you schedule the operation on August 6. However, the drum has 
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been scheduled on August 7. An RLP is said to have occurred. See “Resolving overloads” 

for more information. 

Overloads commonly exist for one or more of the following reasons: 

• You have not identified the correct set of drums 

• You have incorrectly set the buffer sizes 

• Insufficient capacity is available on the non-drums. 

Verify Protective Capacity Pass relies on the accuracy of data at all workcenters, not just drums. If your data is 

incomplete or incorrect, or you cannot rely on your output, Verify Protective Capacity Pass continues to create an 

overload. 

Verify Protective Capacity Pass does not consider setup times when it calculates a load on non-drums. It cannot 

exactly determine when non-drums will incur a setup because setup times are considered variances in the system 

and should be handled by: 

• Using longer buffers 

• Setting aside some capacity on non-drums. 

You cannot use Verify Protective Capacity Pass to schedule non-drums. It is a tool to verify that there is enough 

capacity on non-drums to support drum operations. 

 

Resolving overloads 

You can use one of the following options to resolve Red Lane Peaks (RLP) and First Day Loads (FDL): 

• Increase queue buffers. If many workcenters exist with unacceptable overloads, and most products already go 

through some drum in their product structure, your plant has insufficient capacity to support the queue buffers 

you have specified. Increase the queue buffers and restart the scheduling session to see a reduction in the 

overloads. 

• Declare a workcenter a drum and schedule it. If the peaks on a workcenter cannot be resolved by normal 

actions, the workcenter is a drum. Subordination stops. After you schedule this Workcenter as a drum, you can 

re-run Subordination. 

If workcenters with high overloads process many products that do not go through a drum, you may have to locate 

another drum in your plant. Select the workcenter you suspect may be a drum. Double-click it and select Exploit 

> On Next Harmony. If Thru-Put can schedule this Workcenter as a drum without violating the existing schedules 
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for other drums, it shows you a drum schedule. Otherwise, you may have to restart by declaring the workcenter 

an additional drum using the L:C chart. 

 

Write Schedule Pass: Fixed Rope Symphony 
When you use Write Schedule Pass, Thru-Put ignores the capacity of non-drum workcenters when it generates the 

rope length. The fact that you have identified some workcenters as drums means you acknowledge that non-drums 

have more capacity than drums. You can speed up your system by unbalancing the capacity between your drums 

and non-drums. Write Schedule Pass uses the projected completion dates and drum schedules to compute the 

material release times and non-drum dispatch times based on buffer sizes and the processing times of the parts 

through the workcenters. 

Generating a schedule 

To generate a schedule: 

1. Load data from either Synchronization or Resynchronization. 

2. Select Steps -> Subordinate -> Write Schedule Pass ... to write schedules. 
 

 

• Upload Schedule to iSeries ERP Syatem checkbox will be enabled only when config.ini 

parameter ERPSystem=XA under "System" section else it will be disabled. 

• Upload Schedule to iSeries ERP Syatem checkbox will be checked/UnChecked based on config.ini 

parameter iSeriesUpload value i.e. 0 or 1 under "Schedule Outputs" section. 

• If user has checked Save Changes to System Configuration checkbox then application will write checkboxes 

values in config.ini file related to this dialog options. 
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• If user has checked the Close Thru-put Application after Writing the Schedule checkbox then application will 

close automatically after writing the schedule. 

Material release schedules may take a long time to write. Write Schedule Pass writes them separately. You can write 

shop floor schedules, material release schedules, and purchasing signals at the same time, however. 

Pulling in Early orders 
After you have scheduled all your drums, you can pull all early orders in. Select Steps > Subordinate > Pull Early 

Orders In. A list of orders that can be pulled in appears. 

Thru-Put attempts to schedule a task on a drum no earlier than it is needed. However, because of capacity conflicts 

on the drum, Thru-Put may schedule some tasks earlier than they are needed. For orders that belong to these tasks, 

you can pull in the due date of your order and deliver it earlier to your customer. 

Thru-Put computes the latest due by (LDB) for each task on the drum. See “Exploiting the constraint: Harmony” for 

more information. If a task is scheduled before LDB, it can be pulled in. A task can be scheduled on the drum before 

its LDB for following reasons: 

• The drum capacity is not available at LDB, and thru-put has moved the task to an earlier time 

• A setup or batch has been saved using lookahead tradeoffs. 

For example, you have a customer order due on October 30. Based on buffers and processing times, the LDB of the 

task on drum is October 18. However, thru-put schedules the task on the drum on October 12 to save setups from a 

previous task. Since the task is scheduled on the drum six days early, the order can be pulled in by six days. 

After you have scheduled all your drums, you can pull all early orders in. User can view the list of orders that can be 

pulled in to an earlier date as they are scheduled earlier on the drums from "Pull Early Orders-In" sub-menu option 

which is under the Steps->Subordinate menu. User can pick the orders from the list that he actually wants to build 

earlier. The number of days the orders are allowed to be pulled in already accounts for making sure that none of 

chanins violate any material restrictions or horizon start. However, one potential pitfall to pulling in orders 

indiscriminately is that it may cause overloads on non drums. 

 

This menu option will be enabled after all drums has been harmonized i.e. just before write schedule Pass else will be 

disabled. So, the user can review orders to pull in just before write schedule pass only. 
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Initially both sales and forecast orders will be selected. User have the option to select either all sales orders or 

forecast orders only to be pull-in by using order type checkbox options. If user wants to pulled in all sales orders only 

then uncheck "Forecasts" checkbox. 

There is another filter for days which indicates by how many days we can pull-in a given order. This days value which 

you see in grid is the difference between "Projected Completion" and "Current Completion". The current cumpletion is 

when the order is due and projected completion is the earliest date to which the order can be pulled in upto this date. 

So, lets assume If you have applied the days filter for 30 days and selecting only customer orders which can be 

pulled in by more then 30 days. 
 

 

Important: There is a config parameter UseNeeddate which indicates the order should be pulled beyond need date 

or should be pulled in beyond promise date. Based on this parameter value the checkbox shown in the dialog will 
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have corresponding label. If UseNeedDate=1 then checkbox label will read as "Pull Orders Beyond Need 

Date" else it will read as "Pull Orders Beyond Promise Date". 

• If this checkbox is checked for the selected sales order then that means this order will get pulled-in upto project 

completion of this sales order else if it left unchecked then the sales order will not be pulled in beyond 

Promise/need date depending upon if UseNeedDate parameter value is 0 or 1. 

• If the config.ini parameter UseNeedDate=0 and "Pull Orders Beyond Promise Date" checkbox is unchecked then 

when you pull the order in, then Projected Completion will be pulled in until Promise date of the sales order. 

From below screenshots you can see that: 

 In the above screenshot you can see that the sales order "ORD007" Projected Completion is "01/17/2023", 

Promise Date is "02/01/2023" and Current Completion is "04/17/2023". When this order to be get pulled-in by 

unchecking "Pull Orders Beyond Promise Date" checkbox. You can see the Current completion of the sales 

order which is upto to promise date of the sales order. 
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• If you are pulling this order in by checking "Pull Orders Beyond Promise Date" checkbox then this sales order 

can be pulled in upto Projected completion of the sales order i.e. "01/17/2023". 

• If the config.ini parameter UseNeedDate=1 and "Pull Orders Beyond Need Date" checkbox is not checked, then 

when you pull the order in, then Projected Completion will be pulled in until Need date of the sales order. From 

below screenshots you can see that: 

 

 

• This parameter does not affect pulling in forecast order and they will be pulled-in upto Target Date of the forecast 

order if the Pull In Beyond Promise Date checkbox is not checked. 

To see the list of orders that have been pulled in the current scheduling session, select Session Results-> List of 

Orders Pulled In. 

We are also retaining Pull Orders Beyond Promise/Need date checkbox value in config.ini under system section 

parameter name "PullInEarlyOrdersBeyondPromiseDate". So, last time if you have checked this checkbox then 

next time it will show you as checked in dialog. 

Review Orders to Push out: Non-Drum 
After all the drums have been scheduled and before the subordination process, Thru-put computes the earliest finish 

date of the orders. It uses the earliest start time (EST) calculation for the order. If the EST of the order is beyond the 

current due date, the order is pushed out. See “Earliest start time” for more information. Since drums have already 

been scheduled and due dates have been pushed out along drum chains based on expedite time (ET), only non-

drum chains contribute to any further pushing out. 

The EST along the non-drum chains is different for new orders as compared to previously scheduled orders. For 

previously scheduled orders, Thru-put ignores the buffers for pushing out along non-drum chains. Thru-put pushes 

out the order only by interceding time. If this order has been seen by Thru-put before, it has already been pushed out 
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once along non-drum chains based on full buffers. Pushing out a scheduled order along non-drum chains every time 

will lead to a creeping effect in which the order is pushed out in every scheduling session. However, new orders are 

pushed out by accounting for buffer. 
 

 

For example, a scheduling session is done today. A new order is found with a due date of today, and the product 

does not go through any drum. Thru-put computes the earliest finish time of this order by computing the EST for the 

order. It pushes out the order. If a scheduling session occurs later this week, this order must not be pushed out again 

by the buffer. Thru-put pushes this order out only if the interceding time is greater than eight days. It does not push it 

out by buffer. 

Customer Orders Pushout Report 
Tracking the customer order throughout the order life cycle is a very important part of supply chain execution. During 

Thru-Put scheduling, customer order can be pushed out because of material constraint and capacity constraint. 

Narrowing down as what caused a given order to get pushed out from output schedule is complex and time 

consuming. To help users with this, we have now added a new feature in Thru-Put to generate a consolidated report 

where users can quickly see what all orders have been pushed out; which caused the push out i.e. which drum or 

material constraint and by how many days. In other words, Thru-Put engine will track and maintain a log of every 

order at every decision (material planning or drum harmonizing etc) which could result in push out of order throughout 

the scheduling session. 

This consolidated log will get written out in plant directory when user performs Write-Schedule Pass and the same 

can be viewed by user in TPWeb via a new web report called “Customer Order PushOut Report” added 

under Reports menu. 
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Back-End Processing: 

Currently in Thru-Put planning engine, we are capturing customer orders information that were pushed out either from 

harmony screen or Material planning screen or non-drum chain processing during planning session, and writing those 

out to an xml file when write schedule pass is done. 

This xml file is generated in Plant folder and is named “PushedOutOrders.xml”. This xml file will be parsed and 

loaded by TPWeb Report named “Customer Order PushOut Report” to display HTML kind layout. This report will 

help users to identify which drum is causing much amount of push out which will eventually help planners to take 

corrective actions timely by focusing on drums/materials which are causing majority of push outs. 
 
We have recorded pushed out orders in xml file from below screens: 

 

Pushing out from Harmony screen 

Thru-put lets you push out individual order or all late orders when in harmony. 

Pushing all late orders out: 

Pushing late orders out is typically the last feasible option. Existence of red tasks on the Harmony screen indicates 

late orders that are marked in red color and must be resolved before you can move on by clicking “Push all orders 

out” toolbar button from right pane or from harmony popup menu option “Push all late orders out”. 

Pushing out a specific order: 

• Select a task for the specific order by left-clicking the task. 

• Right-click on the task and select “Push Order Due Date Out” from popup menu options. Thru-put pushes 

out the order by the minimum possible amount. 

On order push out in harmony, xml nodes will be created for customer orders that are pushed out because of drum 

capacity constraint. And the given Sales Order node will have given child drum node (indicating the drum which 

caused push out) as highlighted in below example: 

 

<Sales UniqueId="0" DemandKey="4" OrderID="ORD004_124" ProductID="BAGMM85" Quantity="17.000" 

CustomerID="GUIDANT" CustomerName="" PromiseDate="08/20/2017" TargetDate="08/18/2017" 

ProjectedDate="03/16/2020 08:00" Lateness="941"> 

<Drum ID="MLG11X" DueDate="08/18/2017" ProjectedDate="03/16/2020" Days="941" Comment="Capacity"/> 

</Sales> 
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Above xml nodes indicate, customer order “ORD004_124” (here 124 is the line no) for the product “BAGMM85” has 

been pushed out from the drum “MLG11X” due to capacity constraint by 941 days (Lateness="941"). Previously it 

was due on the date “08/18/2017”. After pushing this order out new projected date gets calculated. Now the new 

projected date for customer order is “03/16/2020”. 

Note: Please note If a same customer order is pushed out from multiple drums then multiple entries will be added for 

each drum node under same sales order node. Please refer to below example for the same: 

 

<Sales UniqueId="0" DemandKey="19" OrderID="ORD019_139" ProductID="CMP0C10" Quantity="35.000" 

CustomerID="HONDA" CustomerName="" PromiseDate="08/20/2017" TargetDate="08/18/2017" 

ProjectedDate="03/20/2020 08:00" Lateness="945"> 

<Drum ID="MLG11X" DueDate="08/18/2017" ProjectedDate="03/17/2020" Days="942" Comment="Capacity" 

/> 

<Drum ID="FRG100" DueDate="03/17/2020" ProjectedDate="03/20/2020" Days="3" Comment="Capacity" /> 

</Sales> 

• “ProjectedDate” attribute of sales order node indicates final Projected_Completion of customer order after order 

has been pushed out. 

• “Lateness” attribute of the sales order node defines number of days by which given customer order is pushed 

out overall. 

• “Days” attribute of drum node defines the number of days by which the customer order is pushed out from given 

drum. 

Pushing out from Material planning 

Customer Orders can also be pushed out because of Material constraint where existing supplies for Buy Items are 

not available on the date required by end demand. 

Mismatches between supply and demand generate lateness. Supply is determined by the quantity on hand and the 

purchase orders. Demand is determined from sales orders and forecasts. This lateness factor is used in Material 

Planning when pushing out customer orders. 

When a customer order is pushed out due to material constraint in supply demand screen, a Material node will be 

added under sales order node and a work order node i.e. demand node also be added under Material node that is 

consuming the given raw material. Please refer to below example: 

 

<Sales UniqueId="0" DemandKey="38" OrderID="ORD038_103" ProductID="CMP0M85" Quantity="33.000" 

CustomerID="BRISTOL" CustomerName="NOVA" PromiseDate="08/09/2017" TargetDate="08/09/2017" 

ProjectedDate="02/06/2020 08:00" Lateness="911"> 

<Matl ID="BLADERM" Comment="Material"> 
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<WorkOrder ID="PLANNED" WOKey="1198" DueDate="08/09/2017" ProjectedDate="02/06/2020" Days="911" 

Comment="WO Due Date is 01/27/2020" /> 

</Matl> 

</Sales> 

Above example indicates that customer order “ORD038_103” (here 103 is the line no) for the 

product“CMP0M85” has been pushed out due to material shortage for the raw material “BLADERM” by 911 days 

(Lateness="911"). Previously this customer order was due on the date “08/09/2017”. After pushing this order out new 

projected date gets calculated which comes out as “02/06/2020”. Note: If multiple work orders (either PLANNED or 

OPEN) are consuming the same raw material then multiple work orders entries will be added under the Material node 

for each work order. The ID attribute of work order node in xml file will be shown as “PLANNED” for planned work 

orders else work order ID will be shown for open work orders. 

Please note, application also checks for push out caused by material shortage right before user performs WSP (user 

can check customer orders which will get pushed out from non-drum chains by clicking on Review Non-Drum Push 

Outs under Steps -> Sub-Ordinate menu). For all such customer orders which will get pushed out from non-drum 

chains, a Material node will be added under given sales order node as shown in below example: 

 

<Sales UniqueId="0" DemandKey="79" OrderID="ORD079_211" ProductID="SHFT380" Quantity="3.000" 

CustomerID="PENNMAC" CustomerName="" PromiseDate="07/30/2017" TargetDate="07/28/2017" 

ProjectedDate="01/21/2020 08:00" Lateness="907"> 

<Matl ID="SHFT380" Comment="Material"> 

<WorkOrder ID="SHFT380" DueDate="07/28/2017" ProjectedDate="01/21/2020" Days="907" Comment="WO 

Due Date is 01/09/2020" /> 

</Matl> 

</Sales> 

 

Pushing out customer orders from material planning and 
harmony screen both 

If a customer order is pushed out from material planning and same order gets pushed out from Harmony screen too, 

then both material node as well as drum node information will be written out to the XML file for the given sales order 

node. Please refer to below example: 

 

<Sales UniqueId="0" DemandKey="45" OrderID="ORD045_167" ProductID="CMP0M85" Quantity="12.000" 

CustomerID="ROCKWEL" PromiseDate="09/02/2017" ProjectedDate="03/27/2020" TargetDate="09/01/2017" 

Lateness="938"> 
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<Matl ID="BLADERM" Comment="Material"> 

<WorkOrder ID="BLD2M85" DueDate="09/01/2017" ProjectedDate="01/20/2020" Days="871" 

Comment="WorkOrder dueDate : 01/08/2020" /> 

</Matl> 

<Drum ID="MLG11X" DueDate="01/20/2020" ProjectedDate="03/27/2020" Days="67" Comment="Capacity" /> 

</Sales> 

IMPORTANT: Application holds all the pushed-out orders information in memory until Write schedule pass gets 

completed. If application is closed before WSP, then this pushed order information will be lost and will not get written 

to xml file. 

 

PushedOut orders report in TPWeb 

After completing write schedule pass from resonance engine, login to TPWeb with same plant for which WSP was 

done from resonance engine. 

Click on sign in button to login and go to “Reports” menu. Under reports click on “Customer Order Pushout 

Report” from left panel. 

It will display consolidated report for the orders which were pushed out during planning session either due to capacity 

constraints, material constraints or non-drum chain long processing time. 

 

 

If user wants to get the drum-wise summary of push-outs, please click on Drum Summary link button available at top 

right corner in this report. 

Drum Summary report will display the number of orders which were pushed-out at each drum. This view is helpful to 

evaluate which drum is causing maximum pushout. 
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Record & Replay in Thru-Put 
Record and replay functionality in ThruPut enables users to record a scheduling session and save it into a file to 

replay it later. All actions will be replayed by the system itself as recorded. The record log is prepared as an XML file 

named RecordLog.xml and written to the main application installation directory. This XML file can be edited to 

change parameters or delete or add menu commands. However, system is not capable of finding logical faults in the 

XML file, so responsibility of giving correct record log (if edited) lies with the user.   

Under the file menu, user will see two new options viz. “Start Recording” and “Replay Session”. 

Start Recording: User will be presented with classical file save window to select a file. However, the extension of the 

file must be .xml. System will throw an error message if extension of the file is changed. Clicking on this option will 

reset the record log and start recording user actions. User will see a tick mark with this menu item when system is in 

recording mode. Clicking the same menu option can stop recording and tick mark with the menu item will disappear. 

Recording cannot be started after entering into Sync/resync sessions. 

 

Replay Session: This menu option will start replay of recorded session. This option is available only before going 

into sync/resync and will be disabled if recording is on. After replaying the recorded actions, system will resume the 

manual mode. 

 

Following actions can be recorded: 

• Load project 

• Synchronization 

• Re-synchronization 

• Next Harmony (with setup saving factor) 

• Push out all Orders 

• Clean Up 

• Resolve Past Due 

• Schedule New Tasks 

• Write sched Pass (with initial dialog) 

• Automatic Overtime 

• Save Setup TradeOff 

• Pause and Continue 
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• Start Material Planning 

 You can also insert a Pause command while recording a session which will instruct the software to pause the 

replaying session for manual review and paused session can be continued thereafter. Pause and Continue 

commands are available in File Menu. 

Once a session has been recorded, you can open Sync Engine and goto File Menu and use Replay session to run an 

automated scheduling. This can be launched from DOS via:  

D:\Thru-Put70>Resonance –nPlantName –xFileName 

the *.xml file in the plant folder will be picked up with the above command. 

Automatic Sync and Manual ReSync Process Templates 
instead of creating a session recording 

With existing record and replay feature, adding or removing a drum makes the entire log useless. For such cases, 

customer has to re-record the log file and then only can use the replay feature. This is very time consuming for 

customers who have many drums declared. To overcome this drawback of replay feature, there is an additional 

feature for automatic replay of Sync and Manual ReSync Process instead of creating a recording.  

This automatic process will simply execute all basic steps generally performed in Sync and ReSync processes.  

• For Sync, it will execute the steps: Load Project -> Sync -> Harmony -> Save Setup TradeOff -> Push Out -

> WSP.  

• For ReSync, it will execute the steps: Load Project -> ReSync -> Harmony > Clean Up -> Resolve Past 

Dues -> Schedule New Tasks -> Save Setup TradeOff -> Push Out -> WSP.  

For both SYNC and RESYNC, the steps from harmony to Push out will get executed for all drums declared by 

customer.  

Two new xml templates have been for Sync and ReSync which are named as ManualSyncTemplate.xml and 

ManualReSyncTemplate.xml respectively. Each template lists down the steps mentioned above and will reside in 

main installation folder. By default, the lookahead value defined in both these templates is 5 (days/mins/factor 

depending upon LookAheadInDays config parameter). Customer can change the lookahead factor value in the 

generic template files for Sync/ReSync and can use the same and can also rename the files accordingly. To run 

replay session using this generic template, all we need is to click on Replay Session and browse to any of these 

generic template files for Sync/ReSync for replaying automated Sync or Resync session accordingly. 
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Interpreting Schedules and Reports 
Non-drum schedules, material release schedules, and planned work order schedules have start dates associated 

with them. These start dates imply that you should take the specified actions no sooner than the start date and as 

soon as possible after that date. The following are the lists, schedules, and reports: 

• Non-Drum Dispatch List 

Use the sequence on this list as a guideline for the sequence of the work on a workcenter. You should not start a 

task on a non-drum before the start date of that task, but should start it as soon as possible after the start date. 

For example, drum operation 5 is scheduled on August 7. Thru-Put schedules the preceding operations 120 

hours before the scheduled date since the Murphy and Queue buffers are about 120 hours. 

All operations have a start date of July 31, but they may not all start on that day. In fact, step 4 will finish on 

August 5 since it is scheduled on the drum on August 7 and must be brought to the drum early. The operations 

should not start before August 31 but should finish before August 5. Job step 1 should start on July 31 or on the 

earliest possible date after that. Job step 2 should start no sooner than July 31 in case job step 1 started early. It 

should be started after job step 1 is finished and as soon as possible after July 31. 

You can schedule non-drums automatically by controlling the release of material. This simplifies schedule 

management since you do not need to monitor schedules on non-drums daily. If the raw material in the example 

is not released before July 31, job step 1 does not start before July 31. Manage non-drum schedules as an 

exception, not as a rule. 

 

• Material Release Schedules: Material release schedules can almost automatically monitor non-drum schedules. 

Material should be released no sooner than the release date, but as soon as possible after the release date. 

• Planned Work Orders: Release work orders for parts no sooner than the start date but as soon as possible after 

the start date. 

• Protective Capacity: On a gross basis, non-drums have excess capacity, so you can set some of this excess 

aside. This is the concept of protective capacity. Two questions arise with finite capacity systems: 

o What if Murphy strikes? 

o What if two or more jobs compete for non-drums and some jobs have to wait before they can be processed? 

Jobs can arrive late into a buffer and some buffer is consumed. The drum is still protected because the job still 

gets to the job step before it is scheduled. However, workcenters that feed the drum will have fallen behind. If 

they do not recover, the buffer may not be restored, and the protection will be less with every successive 
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disruption. To prevent this, give non-drums additional capacity over and above the scheduled load so you can 

restore the time buffers. 

Using Thru-Put Reports 

Once Write-Schedule Pass is performed, Thru-Put writes the output schedules (i.e. Drum Schedule, Non-drum 

schedules, Material release schedules and planned work order schedules) in output tables in Thru-Put database. 

Along with this, it also creates back-end views needed for various reports which can be used by planner, shop-floor 

personnel and Purchasing departaments. 

User can run these reports from either the Synchronization engine or via a web browser i.e. TPWeb. To see reports 

from the Synchronization engine, do the following: 1. Select Reports > Run Report. A dialog box appears. 2. Choose 

a report from the dialog box and click next. The option box appears. 3. Choose the options you want to use and click 

next. Your report appears. You can do the following with the report: 

• View. 

• Save to disk. 

• Email. 

• Print. 

Note: You must run a new report after each new scheduling session or after you incrementally schedule. If you do 

not run the reports again, the information in the report may be out of date. 
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Out Data Files 

After Write-Schedule Pass, the schedule generated by SYNC engine in output tables in Thru-Put database can also 

be uploaded back to ERP system (XA/LX systems only) via 6 .out files. These .out files are written out 

in InputFileDir folder when CreateDataFiles=1 in config.ini. And can be uploaded directly to ERP System, if user 

checks the option "Upload Schedule to iSeries ERP System" in Write-Schedule Pass dialog. Alternatively, user 

can upload these files later on, using APDatalink utility (a DOS Command utility). 

If you want to view these Out Files in Sync Engine, please click on Reports -> Thru-put Schedule .Out files menu 

option. 
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1. PPPLNO.OUT => Planned Order file – All Open and Planned Supply information (Make and Buy). 

2. PPRTGW.OUT => Routing Operation Start for make Items both Open and Planned Work orders. 

3. PPRACW.OUT => Reschedule Activities (Expedite/defer) for open Supplies if any (Make and Buy). 

4. PPREQM.OUT => Requirements File (Item Requirements date and qty for all dependent demands). 

5. PPCUST.OUT => Customer Order Scheduled Delivery dates (Sales projected Completions). 

6. PPDMDR.OUT => Source of Demand File (Supply Pegging at all levels to Customer Orders). 

As an example, if you want to view Planned Orders file, then please click on Reports->Thru-put Schedule .Out 

files->Planned Order(PPPLNO.out) menu option. It will read the PPPLNO.out file from directory path specified 

in InputFileDir config flag, will parse it field-by-field (as per standard offset defined for each field) and display it in grid 

as shown below: 
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Note: For more details on the offset specified for each field and each field details, please refer to section Useful 

Resources -> Out Files in this Help file. 

By default, the grid displays 5000 records at a time. User has the option of moving to next page or previous page 

using "Next" and "Previous" buttons displayed at the top of the grid. 

There are quite a few menu options available when user performs Right-click on any cell in the grid such as "Copy 

Cell", "Find..", "Filter..". Please note, "Find" option works across pages; while "Filter" option filters records only in 

current page. 
  



THRU-PUT Advanced Planning and Scheduling User Guide  

  
Infor Confidential- Please do not distribute Page 134 

Understanding Buffers 
There are two modes of buffers supported in generating a plan. They are global (TOC) buffers and flexible buffers. 

The default planning mode is global buffers. The user can switch to flexible buffers mode by setting up 

the FlexibleBuffers parameter in the config.ini file to 1. 

Global (TOC) buffers 

The global buffer concept of drum, shipping, assembly, and queue time buffers are based on the following: 

• Only critical schedules should be protected 

• Queues and variability can be combined to reduce the variability of the system. In other words, pooling the 

insurance reduces the total insurance needed. 

It has following disadvantages: 

• A TOC-based education is required. 

• Multiple product lines may exist in a plant, with no shared resource and with distinct lead times. To plan this in 

single model, a single buffer cannot be used across product lines. 

• Different drums may require different buffers. 

 

Drum: 

You buffer a drum to ensure it does not sit idle when it should be producing work. A buffer at the drum does more 

than provide WIP to keep the drum busy; it lets you make decisions on the shop floor about processing in order to 

save setups on the drum. 

 

Assembly: 

Assembly buffer is required only for assembly operations in which one of the components in the assembly goes 

through a drum, either down- or upstream. For example, an assembly operation assembles parts A, B, and C. None 

require a drum operation upstream and no assembly buffer is required. If part A requires a drum operation upstream, 

parts B and C then require a buffer at the assembly. 

Note: When non-drum parts are assembled with drum parts and only if the customer order generates a task on the 

drum. For a customer order, assembly orders do not offset tasks along the non-drum chains which are assembled 

with drum chains if the order is satisfied by WIP downstream of the drum. 
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Shipping: 

Use shipping buffers to allow you to plan each job to finish ahead of the time it is due to ship. Even if process 

variations delay part of the job, the due date can still be met. 
 

Queue and Murphy: 

Each buffer comprises two components: 

1. Murphy 

2. Queue 

Murphy: Murphy buffers protect against Murphy variance in stations upstream of the buffered location. This does not 

include non-instantaneous availability of capacity on non-constraints. 

 

Queue: Queue buffers are the estimated queues upstream of the buffered location due to non-constraints non-

availability of instantaneous capacity. Queue buffers typically tend to be larger than Murphy buffers. 

 

For each location, queue and Murphy buffers are specified as part of the plant model you decided on when you 

implemented. 

Note: Initially user defined buffer values will be stored in config.ini file under [Time Buffers] section. When database is 

build via DBUtil or thru-put planning application is run, those buffer values will be synced with database 

PLANT_CONFIG table. If buffer values doesn't exixts in plant config table then those config.ini values will be written 

into PLANT_CONFIG table otherwise PLANT_CONFIG table values will be used for planning. Always buffer values 

will be wiped out from config.ini under [Time buffers] section while exiting the current session. 

 

If users wants to change TOC buffers values manually for planning then they need to follow steps as given below: 

• Open "System Configuration" dialog from "file" menu option. 

• From "Buffer Type" group select "Global(TOC) Buffers" radio button. 
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Click on "Time Buffers..." button. "Time Buffers Configuration..." dialog will be displayed as given in the below 

screen. On this dialog users can give new buffer values. After clicking OK button those values will be saved into 

PLANT_CONFIG table and will be used for planning. 

 

 
 
LOCATION_ID PARAMETER_NAME PARAMETER_VALUE 

NDA QUEUE_SHIPPING_BUFFER 40 

NDA QUEUE_CONSTRAINT_BUFFER 32 



THRU-PUT Advanced Planning and Scheduling User Guide  

  
Infor Confidential- Please do not distribute Page 137 

NDA QUEUE_ASSEMBLY_BUFFER 32 

NDA MURPHY_SHIPPING_BUFFER 20 

NDA MURPHY_CONSTRAINT_BUFFER 16 

NDA MURPHY_ASSEMBLY_BUFFER 16 

 
 
Note: From this dialog, users can apply buffers for multiple locations also by changing location from Plant_ID 
combobox and using apply button in a single go. 

Flexible Time buffers 

Flexible buffering lets you set buffers at the individual resource level. You can define both a minimum and typical 

buffer. 

 

Workcenter: 

They are specified at irrespective of wether they are drums or non drums. The buffer values in this case are specified 

in the workcenter table. You can define control points as workcenters with zero buffers but an approximate schedule. 
 

Shipping: 

In addition to workcenter buffers in the flexible buffer mode the user can specify a global shipping buffer. This is 

specified using two parameters, typical buffer and minimal buffer. Typical buffer is used in backward schedule 

calculations and minimum buffer is used in forward schedule calculations. Before planning run or database build via 

DBUtil, these values are specified in the config.ini file. When database is build via DBUtil or thru-put planning 

application is run, those buffer values will be synced with database PLANT_CONFIG table. If buffer values doesn't 

exixts in plant config table then those config.ini values will be written into plan_config table otherwise 

PLANT_CONFIG table values will be used for planning. Always buffer values will be wiped out from config.ini under 

[Time buffers] section while exiting the current session. 

 

If users wants to change "Flexible Time buffers" values manually for planning then they need to follow the steps as 

given below: 

• Open "System Configuration" dialog from "file" menu option. 

• From "Buffer Type" group select "Flexible Buffers" radio button. 
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Click on "Time Buffers..." button. "Flexible Time Buffers Configuration..." dialog will be displayed as given in the 

below screen. On this dialog users can give Min/Typical buffer values for shipping buffer and Workcenter buffers. 

After clicking OK button Shipping buffer values will be saved into PLANT_CONFIG table and Workcenter buffer 

values will be saved into WKCTR table and same will be used for planning. 
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Note: If Min/Typical shipping buffer values are not given either in config.ini file or in PLANT_CONFIG table then 

Default (Typical:16, Minimum:8) values will be used for planning as displayed in the above screen. 

Initially, the workcenters will be displayed in the list those are having +ve Min/Typical buffer values in the WKCTR 

table otherwise the list will be blank. 

 

Users can modify existing values for Shipping buffer or workcenters buffers. For example, if user wants to edit 

Min/Typical buffer values for workcenter MLG11X then he/she need to double click in a grid cell (Updated Min/Typical 

buffer cell) to provide new value and then press enter key to validate newly provided value. After providing new 

values click OK button to save those values into WKCTR table. Updated values will be displayed in green color as 

shown in the resulting sereen. 

Note: For reference existing buffer values are also displayed in Min/Typical buffer column. 

 

 
 

If user wants to give Min/Typical buffer values to the workcenters those are having zero buffer values in WKCTR 

table. Then click on "Add Workcenter(s)..." button, a workcenter list will be displayed in dialog box those are having 

zero buffer values. From the list user can select either single or multiple workcenter(s) to add in flexible time buffer 

dialog and can provide buffer values then click OK button to save values in WKCTR table. 
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Glossary 
alternate routing. A set of bill of materials and routing data that captures another method for 
producing a product.  

aggressive drum buffer. The sum of Murphy drum buffer and a user-defined fraction of the queue 
buffer. Used to calculated earliest start times.  

aggressive shipping buffer. The sum of Murphy shipping buffer and a user defined fraction of the queue 
buffer. Used to calculate earliest start times.  

ASCII (American Standard Code for Information Interchange). A binary character code used to 
represent a character in a computer. It consists of 128 seven-bit codes for upper- and lowercase letters, 
numbers, punctuation, and special communication-control characters.  

assembly buffer. Required for non-drum parts when they are assembled with the drum parts. Required 
only for assembly operations in which one of the components in the assembly goes through a drum 
upstream. Furthermore required only on parts that do not go through a drum downstream.  

autosave batches. Tasks within the same batching family are combined and the interceding tasks are 
pushed out. Batches are combined only if the due dates of orders associated with interceding tasks are 
not pushed out. See “autosave setups” in this glossary and “Reduce Batches: Pure Gains” in the User’s 
Guide. 

autosave setups. Tasks within the same setup family are combined and the interceding tasks are 
pushed out. Automated available-to-promise is achieved by giving order takers access to inventory and 
capacity information, and in some cases, vendor information, so they are able to commit to reliable 
delivery dates while the customer is still on the phone. See “autosave batches” in this glossary and 
“Reduct Setups: Pure Gains” in the User’s Guide. 

automatic overtime allocation. Thru-Put automatically allocates overtime to eliminate or reduce the 

lateness of your orders based on the lateness and your overtime policies. batch. A quantity scheduled 

to be produced together.  

Backward interaction. When job on a given drum arrives after going thru another drum, then job is said 
to have backward interaction. Backward interaction limits how soon a job can be started on this drum 
after completing all other feeding tasks. 

batch production. A manufacturing method used when the lot size of identical parts is produced in a 
factory. Batch production is the method adopted when the required product volumes are not adequate 
to permit continuous product of one product on dedicated machines. 

batching capacity. For furnace-type operations, the amount of parts a workcenter can accommodate 
for each batch, based on the Batch_Size field in the Routing file. If the Batch_Size for Part A is 100 and 
for Part B is 50, each piece of A is assumed to occupy 1/100 and each piece of B is assumed to occupy 
1/50 of the batching capacity. Therefore, a batch of 50 pieces of part A and 25 pieces of part B fully 
occupies the batching capacity. (1/100 x 50) + (1/ 50 x 25) = 1).  
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batch Due Date Quotation (DDQ). A Process of running Capable to Promise on a set of newly arrived 
Sales/Customer Orders. Normally, used for orders received thru EDI (Electronic Data Interchange). See 
Customer Service Workbench or Capable to Promise to learn about quotation.  

batching families. Used to determine whether or not two operations can be batched, based on the 
Family_ID field in the Routing file. Note that the same field is used to determine whether two or more 
operations share a common setup. Thru-Put assumes that more than operation with the same setup 
can be batched if it is a furnace-type operation. However, the run time per batch, as well as the setup 
time, must be the same in order to batch the operations together. 

bill of materials (BOM). A listing of all the subassemblies, parts, and raw materials that go into a parent 
assembly. 

BOM. Bill of materials.  

bottleneck resource. Any resource whose capacity is equal to or less than the market demand 

placed upon it. See “drum.”  

bucket. A time period, usually daily, weekly, or monthly.  

bucketized load. The load within a given period of time or buckets  

buffer. Additional planned lead time used to protect the system from the disruptions inherent in any 
process, or additional inventory used to enable filling customer orders in less than the normal lead time 
(stock buffer). A duration of time used to protect firm schedules generated during the planning process. 
Strategically placed before drums, shipping operations, or some assembly operations or critical resources.  

buffer for fixed rope (BFR) Buffer for a material release schedule based on a nondrum and its 
instantaneous availability.  

buffer penetration. Buffer remaining for an operation relative to the planned buffer expressed as a 
percent.  

= (1 – Buffer Remaining/Planned Buffer)* 100 

Buffer Penetration is predominantly used in priority of individual jobs when multiple jobs are waiting in 
queue to be worked on. Smaller the buffer remaining higher the priority. This value is used in flagging 
i.e. if the operation start is  

a. at warning level (red) – more than 66% penetrated so very less is remaining. Expedite the job 

b. alert level (yellow) – value 33%– 66% penetrated. Expedite the job  

c. on time or running normal (green) – value 0% - 33% penetrated. Nothing to worry 

d. Running too early (blue) – value 0% - 33% penetrated. Check out if the buffer specified is too much.
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buffer remaining. mostly used with non-constraints to see the execution urgency of the job on the 
resource by comparing current date versus the DDB date of the operation. If the DDB Date is greater 
than current date(today) then buffer remaining will be positive value. If DDB Date is less than current 
date, the value will be negative. This is normally expressed as number of hours. Lower the value, higher 
the priority of the job and should be taken up first. It could be also expressed as a percentage by 
dividing by the planned buffer to normalize across different product lines where planned buffer may be 
different. 

burden rate. A cost, usually in dollars per hour, normally added to the cost of every standard production 

hour to cover overhead expenses.  

cacophony. A graphical representation of an infinite backward schedule.  

capacity. Time available at a resource over a period of time. Usually determined by how the resource is 
staffed. For example, capacity at machine A is 40 hours per week.  

CGS. Cost of goods sold.  

child part. A manufactured component or purchase part used in assembly. A part made up of parts that 
have been made previously (parent parts). 

classifying materials. A way of distinguishing orders of importance of materials in a plant. See “ignore 

materials,” “normal materials,” and “priority materials.”  

configuration. The arrangement of components specified to produce an assembly. 

conflicting drums. If you identify drums sequentially, you identify and schedule A first. Thru-Put does 
not know the existence of drum B; therefore, it schedules A assuming there is no drum feeding it. When 
you declare B next, it is quite that B has capacity constraint and cannot be scheduled to meet the 
constraint of drum A. Drum B therefore conflicts with drum A. 

consigned part. A part processed outside, but for which the plant must first explode the BOM and 
manufacture the child parts in-house. Consigned parts differ from outside processing in that they are 
modeled at the part level, whereas outside processing is modeled at the job step level. 

constraint. A limit to the output of a system. In planning, typically the resource with the highest load 
relative to its capacity. See “drum.”  

constraint management process. Constraint-based improvement process consisting of four steps and 
designed to drive continuous improvement in business performance. The four steps are: 1.Identify the 
system's constraint(s). 2.Design operating rules to optimize system performance, given the limitations 
of the chosen constraints. 3.Improve system performance by focusing on the system constraint(s).  
4.Repeat the cycle. 

Customer Service Workbench (CSW). Thru-Put module for Capable to Promise. CSW helps to quote a 
capacity tested Delivery date for a new quotation taking into consideration the current schedule in the 
shopfloor and utilizing spare capacity and materials to give most accurate feasible date.  
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cycle time. The time between completion of two discrete units of production. See “manufacturing cycle 
time” and “order lead time.”  
 
data file. A collection of related data records organized in a specific manner. A simple way of inputting 
your plant and process information to Thru-Put for Planning and Scheduling.  
 
DBUtil. A Thru-Put module that converts data files from any external source into a database that has 
the correct information and structure for Thru-Put. It also helps to extract data from external sources 
using ODBC connection.  

delivery lead time. The time difference between when a customer places an order and when the order 
is shipped.  

demand. A requirement for a particular product or component over time. Expressed by date, quantity, 
and product.  

dependency. Certain operations or activities cannot take place until certain other operations or 
activities have been completed. 

dock-to-stock lead time. The time difference between the time a purchase part product arrives at the 

dock to when the part can be released. drum. The resource with the highest load relative to its 

capacity.  

Don’t-Do-Before (DDB). Start time for an operation before which a non-constraints should not start 

to ensure minimal Work in Process (WIP) in the production floor. Typical or full buffer is added while 

calculating the start time of the non-constraints ensuring even if the non-constraints do not start at 

DDB, final delivery schedule of end product is not jeopardized.  

drum. In Thru-Put, drum refers to any bottlenecks that hinder delivery of customer orders on time. Drum 
term is most commonly used when a machine resource is scarce and capacity constrained. But it could 
be a skilled labor and tool or die or a critical material. The most constrained resource in a plant determines 
the throughput of the plant. You can use one or more of the following techniques to identify potential 
drums: Workcenter queues, Part shortages, Overtime 

drum buffer. Excess capacity from non-drum work centers. Provides protection from fluctuations in the 
flow of materials upstream to a drum. Because a drum has no protective capacity, it must have a buffer 
of materials waiting to be processed. The amount of materials needed in the buffer depends on many 
factors, including the reliability of upstream workcenters, the amount of protective capacity they have, 
and the typical length of disruption when they occur. Allows you to make processing decisions in order to 
save setups on the drum. Exists to ensure the drum does not sit idle. 

drum schedules. Shows you the schedule of the drums in a tabular format. If there is more than one 
drum, a dialog box appears showing a scrollable list of drums. To see the dispatch list of a drum from this 
list, click on the corresponding workcenter and click on OK. This option is not available if you have not 
scheduled a drum. 
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Drum-Buffer-Rope. The technique used to manage resources and maximize thru- put. The drum sets 
the pace of production, and the rest of the machines subordinate the rate at which they produce to the 
drum. The buffers establish protection against variability.  

dynamic rope. A material release schedule on non-drums that considers potential overload and adjusts 
material release accordingly. 

Dynamic rope symphony. Verify Protective Capacity Pass. When you run Verify Protective Capacity 
Pass, Thru-Put considers the capacity of non-drums and dynamically computes the queue times on non-
drums. This contrasts with static symphony (Write Capacity Pass), which does not account for the finite 
capacity of non-drums. Even though non-drums have excess capacity over the scheduling horizon, they 
might be overloaded on particular days and jobs might have to wait in queues. Verify Protective 
Capacity Pass performs backward scheduling to dynamically compute the queue times based on your 
workload. Verify Protective Capacity Pass looks at the effective capacity available on the drum. Effective 
capacity is Total Capacity minus Protective Capacity.  

earliest start time (EST). The earliest possible time for a task to start. In some cases, this time is 
determined by delays upstream or a hard material constraint. In other cases, it is the result of aggressive 
scheduling done by Thru-Put to reduce WIP on the shop floor. 

early orders. Thru-Put tries to schedule a task on the drum no earlier than it is needed. However, 
because of capacity conflicts on the drum, Thru-Put may have to schedule some tasks earlier than they 
are needed. The orders that belong to such tasks are early orders. You can pull the due date of the 
order and deliver it earlier to your customer. 

To compute the earliest possible due date for an order, Thru-Put just computes its LDB from drum tasks. 
To do that, it takes the drum task schedule end, and adds processing time assuming batch overlapping, 
and regular shipping buffer. We can pull early orders in only after the entire Harmony for all drums is 
done. We cannot do it before, because the order that is potentially early after scheduling the current 
drum, can be late after scheduling the next one. 

Enterprise Resource Planning (ERP). The evolution of manufacturing resources planning (MRP & MRPII) 
systems. ERP is the foundation and integration of enterprise-wide information systems. Such systems 
link all of a company’s operations, including human resources, financials, manufacturing, and 
distribution, as well as connecting the organization to its customers and suppliers. 

excess capacity. The amount of a resource's capacity in excess of the thru-put and protective capacities. 
This capacity can be safely eliminated without affecting the integrity of the plant's schedule. 

excess WIP. Work-in-process on the shop floor beyond what is needed for the buffers. 

expedited POs (purchase orders). Purchase orders with a due date (arrival date) after the date of 
requirement on the shop floor. 

first day load (FDL). A task must be performed on the horizon start date and insufficient capacity is 
available.  

fixed rope. A material release schedule tied to drum and shipping schedules based on buffers and 

processing time at non-drum workcenters.  
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Flexible buffers. Another way of specifying buffers for Thru-Put planning where different buffer values 

can be specified for different drums and non-drums instead of one global buffer in TOC Buffers 

methodology. While using flexible buffers, only shipping buffer and resource buffers are added and no 

explicit assembly buffers. However, you can still add resource buffer for any work centers such as 

assembly workcenter to simulate assembly buffers.     

 

forecast. A planning methodology that predicts orders for a product. Expected Quantity of a product sales 

on a weekly or a monthly basis.  

Forward interaction. When job on a given drum needs to go to another drum for further processing, 
how late a job should be scheduled on the current drum also determines when next drum needs to start 
affecting the final completion of all processes.  

Hard pegging. Process of assigning a given manufacturing order or a work order or a purchase order to 
a specific sales or customer order. Work order or PO item may be same as the final customer ordered 
item or may be it’s component. Thru-Put will consume those supplies only against those sales orders. 
Hard pegging helps to refine priority of a particular customer order or special configuration.     

Harmony. The tool used for scheduling a drum that allows for many decision making capabilities in 
order to exploit the drum's capacity and maximize its Thru-Put. 

Harmony chart. A Gantt chart that appears during the harmony process. To facilitate decision making, 

several display options appropriate for finite scheduling are available. Also called L:C chart. idle time. 

Time not used to perform a setup or process (run) material import.  

ignore materials. Materials completely ignored by a Thru-Put for material analysis. For example, screws 
and bolts. 

ignore workcenters. Workcenters sufficiently flexible to handle the load or with inaccurate data. You 
can specify to ignore these.  

interacting drums. A drum workcenter being subordinated to an identified constraint. A higher priority 
drum feeding a lower priority drum does not interact. This interaction should be minimal - if 50 percent 
of tasks from B feed A, then, most likely, only A is a drum. 

inventory. Amount of money tied up in materials that the company intends to sell. Inventory is equal to 
the purchased material value of raw material, purchased parts, work in process and finished goods.  

jobs in progress (JIP). Operations or setups currently in progress on a workcenter, usually a drum. Used 
by Thru-Put to account for significant progress on operations that might otherwise be scheduled for a 
full run. For example, a furnace operation that is 14 days long might be in day 12 by the time a 
scheduling session occurs. 
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L:C chart. A software function that shows load versus capacity information on all workcenters 
sufficiently flexible. To facilitate decision making, several display options appropriate for finite 
scheduling are available.  

late order. An order that cannot be shipped on time based on current planning parameters. In 
Harmony, these appear as red blocks. Lateness may be caused by processing time on non drum chains.  

latest due by (LDB). The latest a task must be completed on the drum to ship the order on time. To 
compute the latest due by for a task, Thru-Put starts with the due date of the order or the due time of 
the downstream drum task and subtracts processing time, assuming batch overlapping and regular 
shipping or drum buffer.  

latest start time (LST). The latest time a task must be started on the drum in order to ship the order on 
time.  

lookahead factor. A user-defined parameter for all setup saving decisions in Harmony. This factor is 
multiplied with the setup or batch time to determine the duration into the future the software should go 
to pull in a task with the same setup or batch characteristics. This ensures that for tasks with longer setups 
will go further out into the future to save setups. The default value is 0.  

manual overtime allocation. Allocation of exact amount of overtime on specific days. Thru-Put 
reschedules the work center to optimize the schedule of the work center after OT allocation. Thru-Put 
allocates overtime for every calendar day (not just every work day) in the range subject to a maximum 
of 24 work hours per day. 

manual placement of tasks. The act of moving a task from one place to another in the Harmony chart.  

manufacturing cycle time. The difference between material release for an order and shipment of the 
release.  

 

market constraint. Demand for the company's products and services is less than or equal to the 
capacity of the organization, or in some other way limits the bottom line performance of the company. 
Includes demand from current customers for the company's different products and services.  

material constraint. Availability of material is less than or equal to the amount needed to maintain the 
planned product flow and to satisfy market demand.  

material consumption. The consumption of material to support utilization of a resource.  

material release schedules. Schedules that specify release dates for materials. Material should be 
released no sooner than the release date but as soon as possible after the release date. These schedules 
can almost automatically monitor the nondrum schedules. 

material requirements profile. A chart showing availability and requirements of materials based on the 
orders in the scheduling horizon. Other options for showing material requirements include lead times 
only; priority materials only; and both lead times and priority materials. 

material utilization. The consumption of material at a process that supports the thru-put requirements. 

minimum lead time. Any of the following:  



THRU-PUT Advanced Planning and Scheduling User Guide  

  
Infor Confidential- Please do not distribute Page 148 

• Firm purchase orders due before today’s date plus a minimum lead time beyond which an order 
cannot be expedited 

• Any firm purchase orders due outside of today’s date plus a minimum lead time that can be 
expedited to today plus a minimum lead time 

• New purchase orders that can be made due today plus a minimum lead time.  

Murphy. Murphy’s law: "If anything can go wrong, it will." Murphy is the knowledge and awareness that 
things can go wrong at any point in a cycle. You must factor Murphy into a schedule. 

Murphy drum buffer. The component of the drum buffer used to protect against Murphy. The 
remaining buffer is used to protect against queues at non-drum workcenters.  

Murphy shipping buffer. The component of the shipping buffer used to protect against Murphy.  

normal materials. All materials other than priority. Unless you ask Thru-Put to analyze Priority Materials 
only, these materials will show up in your analysis.  

OBDC. Open Database Connectivity.  

offload. A decision made during Harmony. The process of moving load from a drum resource to another 
resource.  

offloaded jobs. Tasks that have been offloaded from their original work center to an alternate work 
center. 

outside processing. A specific routing step always sent outside the plant for processing. 

outsourcing. Buying parts which could be made in-house. Indicated in Thru-Putby adding a purchase 
order to the Purchase file. If outsourced parts arrive on different dates, add multiple entries to the 
purchase file. Thru-Put computes the date on which a requirement exists for an outsourced parts. It 
uses the arriving outsourced part for all orders that require the part after the date on which the part 
arrives. If insufficient parts arrive by the required dates, Thru-Put plans to make the parts in-house. 
Thru-Put assumes that all sub-components required for the outsourced parts have either been shipped 
or provided by the vendor. No requirements are generated for the quantity that has been outsourced. 
overhead $ (dollars). Operating expenses minus direct labor dollars. overtime (OT). Hours worked 
exceeding normal labor hours. 

overtime allocation. Thru-Put provides three overtime allocation modes: Automatic Overtime 

Allocation; Manual Overtime Allocation; and using Overtime Allocation from a previous scheduling 

session. parent part. A part produced from one or more components.  

 

planned overtime. Shows by work center the overtime allocated in the current session 

planned work orders. Work orders for parts to be released no sooner than the start date but as soon as 
possible after start date. 
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PO_Qty_Open. A field in the Purchase file that specifies the sum of all purchase order quantities for 

the same item due on the same date. priority materials. Materials that may be hard to procure or hav 

long lead times.  

product mix. The proportion of individual products that make up the total production or sales volume. 

protective capacity. The capacity planned at non-drum workcenters to catch up after murphy hits.  

queue drum buffer. The sum of queuing times the beginning of a rope to the drum.  

queue shipping buffer. The sum of queueing time from a job step after a constraint to shipment.  

R&D (Research and Development) order. An experimental order.  
real time. The immediate availability of data to an information system as a transaction or event occurs. 

red lane peak (RLP). A task has a backwall at a drum but one of the downstream operations needs to be 
done before the backwall. The way Thru-Put handles the lack of availability of material for orders that 
use a hard material but do not go through a drum work center. regular drum buffer. The sum of 
Murphy drum buffer and queue drum buffer. 

regular shipping buffer. The sum of Murphy shipping buffer and queue shipping buffer. 

rope. From Drum-Buffer-Rope (DBR) semantics. A metaphor for the pulling effect of the drum schedule 
on the non-drums' work while material release is tied to the other end of the rope. In other words, the 
drum schedule tightly controls the schedule of everything else. 

safety. The MRP equivalent of buffers. MRP attempts to deal with uncertainty in the system by 
applying safety (a rough estimate of the average Murphy time in the system added to the minimum 
processing time) at each work center. The shortcoming in this approach is that it spreads the safety 
out across the system, rather than focusing it where the safety is needed: at the drum. scheduling 
horizon. The time period for which scheduling is relevant. 

sequential identification. Identifying a second drum only after a first drum has been scheduled. The 
disadvantage of sequential identification is in the scheduling conflicts it presents when you have 
interacting drums. See “interacting drums.”  

setup. A procedure performed on a workcenter or workcenters to prepare for processing a given 

job. setup time. The amount of time required to perform a setup.  

shipping buffer. A buffer that allows for each job to finish ahead of the time it is actually due for 
shipment. Even if process variations delay any job, the due date can still be met. 

simultaneous identification. Identifying more than one drum before performing any scheduling 
activities. Simultaneous identification of drums is best when drums interact with each other, or when 
the sequence of drums is already known. 

SQL. Structured Query Language.  
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Static symphony. Write Schedule Pass. When you use Write Schedule Pass, Thru-Put ignores the 
capacity of non-drum work centers. It does not compute the queue times for every operation on non-
drum. Instead, the queue times are already in the queue buffer that you specify in the system 
configuration file. 

subordinate. The process of preventing non-drum workcenters from producing more work than the 
drum can produce. Eliminates excess work in progress.  

 

supply chain management. The use of information technology to give automated intelligence to a 
network of vendors, suppliers, manufacturers, distributors, retailers, and a host of other trading partners. 
The goal is for each player in the supply chain to conduct business with the latest and best information 
from everyone else in the chain, guiding supply and demand into a more perfect balance. Effective 
management of the supply chain enables a company to move product from the point of origin to that of 
consumption in the least amount of time at the smallest cost. 

Symphony. Synchronization. The tool used for scheduling all of the non-drum resources in a plant so 
that they are subordinated to the drum. 

synchronous manufacturing. A process whereby each process must be completed before the next one 
can begin. An APS philosophy similar to that of TOC.  

Synchronization. The tool used for scheduling all of the non-drum resources in a plant so that they are 
subordinated to the drum. 

Theory of Constraints (TOC). Prescribes that only a few critical resources (called drums because they 
determine the pace) dictate the through-put of a plant. Based upon the observation that a 
manufacturing facility is a complex chain of interdependent resources. Just as a chain (or a set of chains 
connected to each other) can break only at the weakest link, a manufacturing facility can have only a 
few critical resources. See “constraint management process.” thru-put $ (Throughput $). Sales dollars 
minus raw materials cost.  

time buffer. The amount of time materials are released to the production process ahead of the scheduled 
due date. Time buffers protect against uncertainty (Murphy). TOC principles dictate that three kinds of 
buffers are necessary in the system: drum buffers, assembly buffers, and shipping buffers. Non-drum 
work centers generally do not need to be buffered because they have protective capacity. time-phased 
load profile. A chart that shows the orders at a workcenter.  

TOC scheduling. Plant scheduling based on TOC. See Theory of Constraints. 

UDAs. User-defined attributes.  

undo. Reversal of previous Harmony actions in order to facilitate scheduling of What-ifs.  

verify protective capacity. A modelling tool available in Thru-Put. Unless you have accurate data about 
all non-drum workcenters, it is of little use.  

Verify Protective Capacity Pass. When you run Verify Protective Capacity Pass, Thru-Put considers the 
capacity of non-drums and dynamically computes the queue times on non-drums. This contrasts with 
static symphony (Write Capacity Pass), which does not account for the finite capacity of non-drums. 
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Even though non-drums have excess capacity over the scheduling horizon, they might be overloaded on 
particular days and jobs might have to wait in queues. Verify Protective Capacity Pass performs 
backward scheduling to dynamically compute the queue times based on your workload. Verify 
Protective Capacity Pass looks at the effective capacity available on the drum. Effective capacity is Total 
Capacity minus Protective Capacity.  

what-if (WIF). A module in the Strategy Engine of Thru-Put. A hypothetical scheduling decision.  

workcenter. A specific production area consisting of one or more people and/or machines with identical 
capabilities that can be considered as one unit for purposes of capacity planning and scheduling. 

workcenter family. A group of similar work centers. Thru-Put can show loads and capacities for work 
centers with specified families. 

workcenter load profile. A chart that presents load to capacity ratios for the scheduling horizon 
established when Thru-Put was started. The top portion of the chart provides details about the 
workcenter (for example, number of units, ID of the calendar associated with the work center, and the 
work center family). 

Write Schedule Pass. When you use Write Schedule Pass, Thru-Put ignores the capacity of non-drum 
work centers. It does not compute the queue times for every operation on non-drum. Instead, the 
queue times are already in the queue buffer that you specify in the system configuration file 
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